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	 	 Plug	the	power	cord	directly	into	the	outlet	on	wall.	Do	not	use	an	extension	cord.
	 	 If	the	power	cable	or	plug	is	worn	or	damaged,	unplug	the	power	plug	by	pulling	it	out.
	 	 In	order	to	prevent	electrical	shock	or	exposure	to	laser	radiation	(when	using	laser	device),	do	not		
	 remove	the	covers	or	screws	not	stated	in	the	user	manual.
	 	 Turn	power	off	and	unplug	the	power	cord	in	the	following	situations.

	 -	If	something	is	spilled	on	device

	 -	When	considering	the	service	or	repair	request	on	the	device

	 -	When	the	device	cover	is	damaged.
	 	 In	case	of	a	device	using	toner,	do	not	burn	the	spilled	toner	or	the	waste	toner.
	 	If	toner	particles	are	exposed	to	flame,	it	may	ignite.
	 	 In	case	of	disposal,	contact	our	authorized	store	or	use	an	appropriate	collection	place.
	 	 In	case	of	not	using	the	device	for	a	long	time	or	when	leaving	the	office	after	business	hours,	turn		
	 the	power	off.	Otherwise,	it	may	cause	an	accidental	fire.

	 	 Protect	the	device	from	a	humid	or	wet	condition	including	rain,	snow,	and	so	on.
	 	 Pull	the	power	cord	off	from	the	outlet	on	wall	before	moving	the	device.
	 	 Be	careful	not	to	damage	the	power	cord	when	moving	the	device.
	 	 Unplug	by	pulling	out	the	plug,	not	the	cable	when	unplugging	the	power	cord	from	the	outlet	on	wall.
	 	 Be	careful	not	to	drop	a	clip,	staple,	or	any	other	small	metal	object	inside	the	device.
	 	 Be	careful	of	a	safety	accident	when	adjusting	internal	parts	of	the	device	in	case	of	paper	jam		 	
	 removal,	cleaning,	and	so	on.
	 	 In	case	of	a	device	using	toner,	keep	the	toner	and	the	toner	container	out	of	the	reach	of	children.
	 	 Do	not	dispose	of	the	device	or	consumables	at	the	household	waste	process	site.
			 In	case	of	disposal,	contact	our	authorized	store	or	use	an	appropriate	collection	place.
	 	 The	inside	of	the	device	may	be	very	hot.	Do	not	touch	the	parts	with	the	“Careful! Very Hot!”	label		
	 attached	or	its	surrounding	area.	Otherwise,	it	may	cause	burn.
	 	 Our	product	conforms	to	the	quality	and	performance	standards.
	 It	is	recommended	to	use	the	genuine	parts	only,	available	from	an	authorized	distributor.

Please	follow	the	below	guidelines	when	using	the	device.

Cautions	for	User	Safety

Warning	:	Failure	to	follow	the	instructions	may	lead	to	death	or	serious	injury.

Cautions	:	Failure	to	follow	the	instructions	may	cause	serious/minor	injuries	or	property	damages.



Thank	you	for	purchasing	our	product.

This	user	manual	is	intended	for	first-time	user	of	this	MFP	as	well	as	MFP	administrators.

This	manual	explains	functions	and	operation	procedures	of	MFP,	user	tips	and	important	warnings,	
maintenance	tips,	and	simple	troubleshootings.

Read	this	manual	carefully	to	fully	and	effectively	use	the	device.	For	maintenance	and	trouble-
shooting,	basic	technical	knowledge	for	the	device	will	help	users.
For	your	maintenance	and	troubleshooting	needs,	follow	the	instructions	specified	in	the	manual.
If	any	unexpected	errors	or	troubles	occur,	make	sure	to	contact	one	of	our	service	centers	for	help.

Before Use

Prohibition	and	Limitation	on	Duplication

1.		 The	details	of	the	user	manual	can	be	changed	without	a	prior	notice.	Our	company
	 is	not	responsible	for	the	direct	and/or	indirect	loss	or	damages	caused	by	results
	 of	handling	or	operating	the	product	in	any	case	and	for	the	results	occurring	from
	 user’s	negligence.

2.		 The	act	of	duplicating	or	printing	a	bill,	revenue	stamp,	bond,	share	certificate,	bank
	 draft,	check,	passport,	and	driver’s	license	distributed	at	home	and	abroad	is	prohibited
	 according	to	a	law.

3.	The	copyrighted	literary	works	such	as	books,	cores,	figures,	maps,	drawings,	and
	 photos	can	be	duplicated	and	used	for	personal	use	or	household	use	and	within	the
	 same	scope.	In	other	cases,	it	is	prohibited	according	to	a	law.

4.		 The	above	details	present	only	a	part	of	the	applicable	laws	and	regulations.	The
	 details	of	the	law	are	not	stated	as	they	are.	Our	company	is	not	responsible	for
	 correctness	and	completeness.	Receive	a	legal	consulting	service	to	check	if	the
	 duplication	or	printing	of	an	object	is	legal.

5.	 The	font	used	for	device	GUI	and	user	manual	is	NANUM	font,	provided	by	NAVER.
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Before Use

1. About User Manual
 This user manual describes detailed explanations and tips to note in regard to operating and using this device. 
 Before using the device, please read the user manual carefully for user safety and convenience. 
 And keep this manual near the device for your future reference.

 

  -  The details in this user manual may change without prior notice. Sindoh shall not be responsible for any  
   consequent damages or losses, indirect, special, contingent handling or operations of the device in any  
   cases.

  -  Copying or printing to reproduce materials prohibited by law is not allowed.
   Any reproduction of bank currencies, revenue stamps, bonds, stock certificates, promissory notes,  
   checks, passports, driver’s license is generally illegal and prohibited by local law.

  -  The above list is only examplary and not all inclusive. We shall not be liable for either its completeness  
   or accuracy of the above list. When in doubt, please seek legal advice in your local area to find copying  
   or printing of certain material is legal.

 

  -  If this user manual is not followed correctly and the device is operated or adjusted differently from what  
   is stated in the manual, user may get exposed to dangerous electromagnetic waves.

 

  -  The user manual may include descriptions different from the actual device. 
   Some options may not be available in some countries. 
   Please contact your local sales/distributor office for details.

  -  In some countries, a certain device type may not be available. Contact your local seller for details.

  -  This user manual uses two different units for size. Mm and inches are used to show the size of MFP.
   For configuration details, see P. 1-15 「5.4 Set Units」.
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2. How to Read this Manual
2.1 Product and Procedure
 1  Format number “1” means the first step. 

 2  Consecutive numbers are used to describe the next steps for the same procedure.
   - Additional explanations are displayed.

2.2 Symbols in User Manual
 This manual uses the below symbols.

 

  - Incidates important safety instructions.
   Failure to follow these instructions could result in severe injury or death.
 

 

  - Incidates important safety instructions.
   Failure to follow these instructions could result in serious or minor injury, or property damage.

 

  -  Shows required information user needs to be aware of before using device.
   Important notes when using the device or explanations for paper misfeed, damage to originals, data loss.
 

 

  - Provides explanations on device functions and describes required options to use the device.

 

  - This symbol is located where relevant information can be found.
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2.3 Button Keys in User Manual
 Buttons on the Control Panel
     【     】

 Indicates a name for each function button on the control panel.

 Button Keys on Touch Panel
 [      ]

 Indicates a name for button key on the LCD of MFP or button key on computer screen.
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3. Precautions for MFP
 Please comply with the following instructions and “Safety Information” provided at purchase.

3.1 Move MFP

 

  -  Before moving the device, make sure to unplug the power cord from the oultet and separate it from the  
   device. Two or more movers are required to move the device.

  -  Separate the toner unit when moving the device.
   For details on toner unit separation, see P.10-2 「1.2 Change toner bottle」.

  -  Bend your knees enough not to damage your back when lifting the device.
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3.2 Install MFP

 

  -  Install the device with its vents spaced at least 10 cm away from walls and other equipments.

  -  Make sure that there are sufficient space around the device for easy ventilation and operation.

  -  Use the device at temperatures of 10~30℃ and relative humidity of 15~85%.

  -  Do not install or use the device outdoor.

  -  MFP be installed horizontally
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3.3 Ventilation

 

 -  Use the device in a place with good ventilation. When using the device, a small trace of ozone may be  
  created.
  The volume of ozone created is not harmful to human body, but if the volume of ozone accumulates  
  if ventilation is poor and this may become harmful to user. It is recommended to ventilate the space 
  on a regular basis.

 -  Do not block the heat vents of the device. If heat ventilation is poor, it may lead to high temperatures  
  inside the device, resulting in malfunction.

 -  A new MFP generally produces a little amount of gas. Therefore, make sure that the ventilation of 
  space  is good when using the device for the first time. If the device is operating for a long time, it is  
  recommended that you do not stay long in the space where the device is installed.

3.4 Power switch
Make sure that the power cord is plugged into the outlet before turning the power switch on. 
Then turn on the power button on the right side by pressing the switch button to  “I” (On). 
To turn off the power, press the switch button to  “O” (OFF).

 

  - Do not plug or unplug the power cord or touch the power switch with wet hands. 
   It may cause an electrical shock.

 

  - Once you turn the power off, wait 5 seconds or longer to turn the power on again.

  - If you are not using the device for a long time or if you are moving the device, turn the power off and 
   unplug the power cord from the outlet.
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3.5 Power saving mode
 If there is no operation for a certain period of time, the MFP will automatically go into the power saving mode to re 
 duce the power consumption.
 In the power saving mode, all lights in the LCD screen and control panel will become off. User can set a time between  
 1 and 240 minutes as the stand-by time before switching to the power saving mode. By factory default, it is set as  
 “Intelligence”.
 【  】 button will exit the power saving mode manually or switch to the power saving mode.
 User can set whether to go into the power saving mode or exit from the power saving mode after a certain period of  
 time passes. For configuration details, see P. 7-2 「1.1 Basic setting」.

3.6 Handle Consumables

 

  - Do not burn toner unit or developer/drum unit.

 

  - Do not open the toner or other consumables by force. 
   Do not inhale toner powder and keep it away from your skin. 
   Also keep the toner out of reach of children.
   If your skin contacts the toner, clean it with soap and rinse it with flowing water. 
   If you experience any irritation of skin, consult your physician.

 

  - Do not store the toner unit, developer/drum unit, and papers in the following places. 
    Place exposed to flames 
    Place exposed to direct sunlight
    Place with high temperature or humidity                                   
    Place with rapid change of temperature                            
    Place with a lot of dust 
    In vehecle for extended length of time

  -  Do not touch the light sensing surface of the developer/drum unit or expose it to the direct sunlight. 
   It may lower the print quality.

  -  Do not keep the developer, drum, or toner unit upside down or store them in a slanted place. 
   It may lower the print quality.

  -  Do not disassemble the developer, drum, or toner unit.

  -  Keep the developer, drum, or toner unit away from physical impace or vibration.

  -  Do not unpack the developer, drum, or toner unit until you are ready to use them immediately.
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3.7 Precautions in Using the Device

 

 -  The fusing unit and its surrounding areas are very hot while the device is operating.
  Be careful not to touch the fusing unit and its surrounding areas when removing paper jam or looking  
  into the device. It may cause burns.

 -  When removing paper jam or replacing toner unit, prevent your eyes or mouth from toner powder. 
  If toner gets in your eyes or mouth, wash them away with clean water immediately and consult your 
  doctor.

 -  Make sure your hands or clothes are not stained with toner. Wash them away with cold water if your  
  hands or clothes are stained with toner. If you wash it with warm water, the stains may remain.

 -  Use the device only for the functions described in this manual.

 -  Do not remove warning labels or signs.
  When a warning label or sign is contaminated, clean it immediately for clear view.
  When a warning label or sign is contaminated and it is not possible to make them viewable, contact 
  customer support for help.

3.8 Dispose Used Battery
    Ni-MH batteries are installed in the control board of MFP. Dispose batteries in an environment-friendly way according  
 to the manufacturer’s guidelines. Consult a qualified service technician to replace batteries.
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4.  Safety Information
 Plug the power cord into a properly grounded outlet which is close enough and accessible easily from the device. 
 Do not use or store the device in a wet or humid environment.

  Injuries
 - This device uses laser technologies. When you control, alter, or execute procedures not specified in this  
  manual, you may be exposed to hazardous radiations.
  This device uses a method to heat the printing media, so gas may be emitted from papers due to heating.
  To prevent emission of the harmful gas, read and understand the section regarding the details on the  
  printing media in the operating guideline.

 - Follow the below instructions to prevent physical injuries or device damage when moving the device.  
  Press the power switch to turn off the power and unplug the power cord.
  Unplug all cords and cables from the MFP before moving the MFP.
  Do not try to lift optional tray and MFP together; separate MFP from the optional tray to move MFP.  
  When lifting the optional tray, use the handle located on both sides of the tray.
  Use the provided power cord only or use replacement parts approved by the manufacturer only.

 - Do not twist or bend the power cord; do not step on it nor place a heavy weight on top of the cord. Be  
  careful not to damage the surface of power cord; be careful not to apply excessive force on the cord. 
  Do not make the power cord jammed into or between objects such as furniture or walls.
  Misusing the power cord could result in fire or electrical shock. Check the power cord regularly. 
  Unplug the power cord from the outlet first for inspection.
  Please consult a licensed electrician for services or repairs not stated in this user manual.

   Surface Heat
  - The inside of the device may become very hot. Do not touch any heated parts before it is cooled down to  
   avoid any injuries due to the heated parts.

   Electrical Shock
  - When accessing the system board, or installing hardware or optional memory devices, turn off the power  
   of the MFP and unplug the power cord from the outlet before proceeding your work. If the device is 
   connected to any other devices, turn off the power for other devices as well and disconnect the cables  
   from the MFP.

  - This device has been designed, tested, and approved to meet strict safety requirements of international  
   safety standards. Safety features of some parts may be unclear or unknown.
   The manufacturer shall not be responsible for use of any other replacement parts.

  - Disconnect the power cord and all the cables connected to the MFP to prevent any electrical shock when  
   cleaning the outer surface fo the device.
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  Internal Laser Radiation

 -	 Maximum	average	radiation	power:	Max		0.26	μW	(Class	1)	from	the	laser	hole	of	LSU

 - Radiation: 780~790 nm

 - The device includes AIGaAs laser diode with a wave length of 775~800nm and an output of Max.15mW.  
	 	 (Class	3B)

 - TheThe laser diode and the scanning polygon mirror are installed in LSU.

 - LSU is not an item for on-site service. Therefore, LSU should not be disassembled in any circumstances.

LSU
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5.  Notices
  Noise Emission Level

The followings are measured in accordance with ISO 7779 and reported to meet the requirements of ISO 9296.  
Some modes may not be available in your purchased device

Average Sound Pressure at 1 Meter Away

During operation 74 dBA or less

In stand-by 48 dBA or less

 Temperature

Operating emperature 10 ℃ ~ 30 ℃

Shipment and storage temperature -10 ℃ ~ 40 ℃ 

 Dispose Device
Do not dispose the device and consumables as you would normally dispose of household garbage. For disposal or 
recycling inquries, contact your local sales office.

 Laser Notice
The MFP is certified in the U.S. to conform to the requirements of DHHS 21 CFR Subchapter J, and certified 
elsewhere as Class 1 laser product conforming to the requirements of IEC 60825-1:2007. The Class 1 laser products 
are not considered to be hazardous.
The laser system and MFP are designed not to expose laser radiation above Class 1 level to any users during normal 
operation, user maintenance or prescribed service conditions.

 EMC Notice
INFORMATION TO THE USER

This equipment has been tested and found to comply with the limits for a Class A digital device,pursuant to part 
15 of the FCC Rules. These limits are designed to provide reasonableprotection against harmful interference 
when the equipment is operated in a commercialenvironment. This equipment generates, uses, and can radiate 
radio frequency energy and,if not installed and used in accordance with the instruction manual, may cause 
harmfulinterference to radio communications.Operation of this equipment in a residential area is likely to cause 
harmful interference in whichcase the user will be required to correct the interference at his own expense.  

WARNING
Changes or modifications not expressly approved by the manufacturer could void the user’sauthority to operate the 
equipment. 

FCC COMPLIANCE STATEMENT
This device complies with part 15 of the FCC Rules. Operation is subject to the following twoconditions: (1) this 
device may not cause harmful interference, and (2) this device must acceptany interference received, including 
interference that may cause undesired operation.  

This Class [A] digital apparatus complies with Canadian ICES-003.
 Cet appareil numérique de la classe [A] est conforme à la norme NMB-003 du Canada. 
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 Power Consumption
Device power consumption
The below table shows the details of power consumption by the device.

Mode Description

Power consumption (in Watt)

N613, N612, 
MF4091, MF4041

N611, N610, 
MF3033, MF2083

Printing Device is printing paper documents from electronic input 1100W or less 900W or less

Stand-by Device is in stand-by for printing job. 130W or less 130W or less

Power Device is in energy saving mode. 4.2W or less 4.2W or less

Power off Power plug is plugged into the outlet with its switch off. 0.1W or less 0.1W or less

The above power consumption details show an hourly average value. 
Instant power consumption can be much higher thant the average value.

 

  -  User can configure a time for device to go into the power saving mode automatically. For configuration details,  
   see P. 7-2, power saving in 「1.1 Basic setting」.

  -  In the following conditions, the device may not swtich to the power saving mode. 
    When a signal for front or right cover open is displayed                  
    When repair signal is on
    When paper is jammed
    When a signal for toner supply is displayed                                        
    When toner is being supplied
    When initial setup/counter screen is displayed                      
    When fuser is preheating
    When fax/printer or any other function is in operation                                                   
    When printing is interrupted during operation
    When using Onhook dial
    When using recipients or group dial               
    When status LED is blinking

  Deactivated Mode
 Device consumes power even in the deactivated mode. Unplug the power cord to stop the power consumption fully.

  Total Energy Usage
It would be useful to calculate the total energy usage of the device.
As the electricity bill is charged by Watt, you have to multiply time spent in each mode with power consumption in 
order to calculate the energy usage.
The total energy usage is the sum of energy used in each mode.

  Condensation
Rapid change of the ambient temperature may produce fine drops of water on the interior and exterior of the device 
surface.
Wipe the water drops on the outer surface. Open the cover or ARDF of the MFP and let the water drops inside dry off.
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 Supported USB Memory Devices
USB memory devices that have the following specifications can be connected to this machine.

Item Requirement

Interface Compatible with USB Version 2.0/1.1 interface

Format Formatted in FAT32

Security Securities such as data encryption and password lock shall be released, or the security function shall be 
turned Off.

Memory size No upper limit.
• Some USB memory devices may not be supported.
• A USB memory device, which is recognized as multiple drives, cannot be used.

Note the following points when connecting a USB memory device to this machine.
Use the USB connector on the side that is near the Control Panel.
Do not disconnect the USB memory device while saving a file to the device or printing a file saved in the device.
Do not use USB devices (such as hard disk unit and a USB switching hub) except for a USB memory.
Do not connect or disconnect the USB memory when the hourglass is being displayed in the Control Panel while  

   this machine is active.
Do not disconnect the USB memory directly after connecting it.
Use a product that has KC certificate in Korea ; in other places, items with FCC or Ce Mark vice versa.  

  Laser safety
Center for Devices and Radiological Health (CDRH) prohibits on-site repair of laser units. Laser units can be repaired 
only at factories or designated sites. Laser units can be replaced by licensed service technicians only and internal 
parts of laser units may not be replaced on-site. Therefore, customer service technician must return laser units to 
factories or service centers when replacing parts of laser unit.

              

 

  -  Do not remove warning labels or signs. When a warning label or sign is contaminated, clean it immediately for  
   clear view. When a warning label or sign is contaminated and it is not possible to make them viewable, contact  
   customer support for help.
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  WLAN	Notice(Wifi	Kit	is	optional)
 Exposure to radio frequency radiation

The following notice is applicable if your printer has a wireless network card installed.
The radiated output power of this device is far below the FCC radio frequency exposure limits.
A minimum separation of 20 cm (8 inches) must be maintained between the antenna and any
persons for this device to satisfy the RF exposure requirements of the FCC.
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6.  Notice for Wifi Module
 This device is equipped with Wifi module compatible with Sindoh devices only.

Wifi kit (optional) 

Install the kit at this 

location after purchase.

 

  -  This module may cause electronic interference; not allowed for services regarding human security.

  - Keep this module away from water, moisture, and other liquids to prevent damages.

  - Keep this module away from direct sunlight, high temperature, or fire to prevent damages.

 

  - Sindoh shall not be responsible for any malfunction if this module is altered or modified without 
   authorization.

 

  - This modue is installed at a location with minimal human contact to prevent humans from exposing to  
   any electronic waves which exceed the allowed wireless frequency limit set by FCC.

 

Frequency IEEE 802.11b : 2400MHz ~ 2484MHz

IEEE 802.11g : 2400MHz ~ 2484MHz

IEEE 802.11n(20MHz) : 2400MHz ~ 2483MHz

IEEE 802.11n(40MHz) : 2400MHz ~ 2483MHz
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Power density IEEE 802.11b : 10mW(10dbm)/MHz

IEEE 802.11g : 10mW(10dbm)/MHz

IEEE 802.11n(20MHz) : 10mW(10dbm)/MHz

IEEE 802.11n(40MHz) : 10mW(10dbm)/MHz

Number of Channels IEEE 802.11b : 14

IEEE 802.11g : 14

IEEE 802.11n(20MHz) : 14

IEEE 802.11n(40MHz) : 9

Modulation System IEEE 802.11b : DSSS/CCK

IEEE 802.11g : OFDM

IEEE 802.11n(20MHz) : OFDM

IEEE 802.11n(40MHz) : OFDM

Power consumption 5V 500mA(Maximum)

Size 37.0mm X 28.0mm X 3.7 mm

Operating temperature 0 ~ 60 ℃

Storage temperature -10 ~ 80 ℃
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1. Major Functions
1.1 Copy

General copy
User can make copies of originals in various sizes on different type of papers. For details, see P. 2-3 「1) Originals」.

Duplex copy
Users can make copies of originals on both sides of papers.
For details, see P. 2-8 「5) Duplex」

Combined copy
Two, four or eight original pages can be copied on a single sheet of paper. This function can be used with duplex 
copy to  save more papers. For details, see P. 2-15 「9) Combine」.

ID copy
Both sides of your driver’s license or business card can be copied on a single sheet of paper. 
For details, see P. 8-4 「2. ID copy」.

Rotate sort (cross stack)
If you make copies of multiple series, copies can be stacked at different position for easier sorting. 
For details, see P. 2-19 「Rotate sort」, and P. 6-18 「Paper/tray setting」.

1.2 Scan
Scan with computer
User can use TWAIN compatible application to scan documents to computer.
Scanned files are transferred to the application and those files can be edited or saved with the application. 
For details, see P. 4-3 「2. Scan document with computer」.

Scan with MFP
When an image is scanned on MFP, it can be saved in the following ways:

On USB portable memory
As an attachment to E-mail
In the FTP server 
Sent to WebDAV
Save in the share folder

Images can be saved in the following format: JPEG, PDF, or TIFF.
For details, see P. 4-9 「4. Scan setting」.
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1.3 Print
  Print with computer
  User can install MFP driver on user computer to print documents.
  For details, see P. 3-4 「1.2 Update options available with printer driver」.

  Print with USB portable memory
  User can connect USB portable memory or hard disk (HDD) directly to MFP to print saved files. 
  File formats available for printing is PDF document file and JPEG, PNG, TIFF, or other image files.
  For details, see P. 3-8 「3. Print with USB portable memory」.

  
 

   -  Some files may not be supported depending on the compression method of image files.

1.4 Fax (optional)
  Security
  This MFP has improved security by using “Secured Tx and Rx”.
  When “Secured Tx/Rx” is used, a correct password must be entered to start Tx/Rx.

  G3, JBIG, Quick Document Scan and Memory Transfer
  Internal 33.6Kbps fax modem based on ITU-T (International Telecommunications Union Telecommunication) V.34 
  supports G3 communication method so that super speed transmission can be completed in 2 or 3 seconds even  
  when using normal landline. Also it uses new compression format, JBIG, so that documents with included images 
  can be sent super fast.

  Tx/Rx by rotating document orientation
  When document orientation is different from paper orientation, the document image is automatically rotated 90 
  degree to fit the paper orientation. Saved document is also rotated 90 degree for transmission. 
  Therefore, Tx/Rx is possible regardless of paper size or document orientation of recipient.

  Amazing triple action
  While MFP is performing memory Rx/Tx or making copies, other functions or next transmission job can be set.

  Fax transfer
  Received fax documents can be transferred to specified recipients.
  Any faxed documents to your office can be received at other locations or your home and you will not miss or lose any  
  business opportunities.

  Transmission report
  Transmission report can be automatically printed to confirm if your fax has arrived successfully.
  Transmission report can be printed for all transmissions or only for unsuccessfully transmissions with error. 
  For details, see P. 7-40 「4.5 Report」.
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2. Part name and function
2.1 External parts
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# Name Description

1 Auto Reverse Docu-
ment Feeder (ARDF)

Use this handle to open the ARDF.

2 Original guide Adjust this guide to fit the origial width.

3 Original feeder Face up the side of original to scan.

4 Original output Original will be dispensed.

5 LED lamp Lamp color will show the status of MFP.
- Solid green: ready to use.
- Blinking green: working in progress.
- Red: see P. 10-13 「4. Error messages」.

6 USB Insert an external USB to MFP.

7 Dual cover Open this cover to remove a jammed paper or replace fuser unit.

8 Dual cover lever Use this lever to open the dual cover.

9 Manual Paper Tray 
(MPT)

Use this tray to use a different type of papers other than the one in the paper tray. 
Pull the upper part to open MPT.

10 Power switch Press “I” to turn the power on.

11 Tray 2 Supplies papers. Tray 3 and 4 are optional.

12 Tray 1 Supplies papers. Tray 3 and 4 are optional.

13 Front cover Open this cover to replace cartridge or developer/drum unit.

14 Standard Output tray Copied or printed papers will be dispensed through the tray.

15 Control panel Various function buttons are displayed on the LCD panel.

16 Upper Output tray Fax document  is out to this tray. 
From the Settings, you can change this tray for Copy, USB Print’s tray.

17 Power socket Connects the power cord.

18 ARDF cover This is a cover to have cables go through after installing ARDF.

19 USB-B Use it to connect MFP to computer with a USB cable.

20 Ethernet Use ethernet interface cable to connect the network connection device.

21 LINE Connects a landline (optional).

22 TEL Connects additional phone (optional).



Preparation for using MFP

1-6

1

2.2 Internal parts

1

7

2

3

5

4
6

# Name Description

1 ARDF glass Originals sent from ARDF get scanned.

2 Flatbed glass Face down the side of original to scan.

3 Flatbed pad Arrange an original at appropriate position.

4 Fuser unit cover 
handle

To remove a jammed paper, grab this handle and open the fuser unit cover.

5 Fuser unit The fuser unit gets hot when device is working.
Be careful not to get burned.

6 Developer/drum unit Do not touch it with bare hand. 
It may lower the print quality.

7 Toner unit Supplies toner to the device.

8 Developer/drum unit 
handle

Grasp the handle and pull to remove the developer / drum unit. 

8
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2.3 Optional parts
  This section explains the optional parts supplied to this MFP.

1 2

# Name Description

1 Optional tray Two 500-paper trays.

2 Table Use this table when you install the device on floor.

  The above are the optional parts supplied with this MFP.

# Name Description

3 Fax installation kit Use this kit to get fax machine ready to be used.

4 SD CARD Up to 32 GB SD memory card supported

5 Wifi installation kit To set up a WiFi network
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3. Control panel
  The below table shows name and describes function of the buttons on the control panel.

# Name Description

1 [Home] button Returns to home screen after entering each mode.

2 [Reset] button Use this button to reset all settings.

3 [Program] button Use this button to go to the program screen.

4 [Settings] to use when changing the settings of MFP.

5 [Logout] button Push this button to log out from the device after using the device.

6 LCD screen Shows messages and device setup info.

7 [ ＝ ] Shows the status of MFP such as remaining toner, and paper size.

8 [ ] Shows the remaining toner.

9 【 】 button Use to start the selected job.

10 【  】 LED Shows the status of MFP.
Lights green in normal condition, red in abnormal condition.

11 【 】 button Use it to cancel the current job or to delete the entire contents currently entering.
To enter a fax number, this button is used to delete current input one letter by one.

12 【 】 button Enables power-saving or max power-saving mode and returns to ready if in pow-
er-saving mode or max power-saving mode.
- Short press: power-saving mode
- Long press (more than 2 seconds): max power-saving mode

13 USB port Use this to plug USB drive in to the MFP.

14 NFC area to use when linking NFC supported mobile devices. 

6

1 2 3 4 5

7 9 10 11 12 13148
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   -  In power-saving mode, TX of document saved in memory, fax RX, print job RX from other computers are 
    available.

   -  In the following conditions, MFP will not enter the power-saving mode.

    Scanning documents

    Printing copies or faxes

    Printing documents

    Printing errors such as paper jams or low toner

    Transmitting faxes

   -  For the following cases, the device automatically exits power-saving mode.

    Receiving faxes

    Receiving print job from computer

    Setting document on ARDF flatbed

    Pressing buttons or LCD control panel
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4. Enter text
  When user needs to manually enter email address, FTP address, or file names, a virtual keyboard appears on the  
  LCD display. Use this virtual keyboard to enter letters, numbers or special characters.

4.1 Manual input screen

2

1

3

  A virtual keyboard appears when user presses the input field on the LCD display.

# Name Description

1 [123] key Toggles to keyboard to enter number or special characters.

2 [Korean] key Toggles between Korean letter keyboard and English letter keyboard.

3 [  ] key In English letter keyboard, toggles between upper case or lower case. In Korean letter 
keyboard, toggles between simple consonant and double consonant keyboard.

4.2 Letter input screen  

  Shows entered letters.



1-11

Preparation for using MFP 1

4.3 English alphabet input

  The screen will switch to English alphabet input screen.

4.4 Number or symbol input

  Select [123] on the bottom left of the LCD display. 
  The screen will switch to number and special character input screen.

4.5 Korean letter input

  Select [Korean] on the bottom left of the LCD display. The screen will switch to Korean letter input screen.
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4.6 Modify letter input

  To edit inputs, press[ ]to delete all inputs to modify and enter characters again.
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5. Basic setting
5.1 Basic setting options
  Set up necessary options before using MFP.

Language
Select a language to display on the LCD screen.

Time
Enter a current time to display. The current time entered will apply to all fax functions including fax transmission and 
communication management. Enter year, month, day, hour, and minute.

5.2 Setting mode screen
  1  Select [Setting] on the LCD home screen to enter the setting mode.

▼

  2  Select and set up each option as needed.
    To apply your selections, make sure to press the [Save] button.

  3  After finishing setup, press the 【 】 button to return to the home screen.
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5.3 Language
  Select a language to display on the LCD screen.

1  On the home screen, select [Setting]→ [General] → [Language].

▼

▼
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2   Select a language to display on the LCD screen and choose [Save].

5.4 Unit
Select a unit to display on the LCD screen. 

1  On the LCD home screen, select [Setting] → [General] → [Basic] and scroll down to go to [12-Unit] and   
  choose [mm] or [inch].

5.5 Time
Enter the current date and time as the following order: year (YYYY), month (MM), day (DD), time (24 hour format, tt), 
minute (mm).

1   On the home screen, select [Setting]→ [General] → [Basic].

▼
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▼

2  Scroll down to [6-Time] and enter a date and time with number keys.
  - On the LCD screen, select year, month, day, am/pm, hour, and minute one by one to enter a value.
  - Select [Time set] and enter the time zone you are in.

3  After finishing setup, select the [Change] button on the right of the time setting.
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6.  Original and paper
6.1 Original and paper size

This section explains the signs for originals and papers in the user manual.
When showing the original or paper size, Y means width and X means length.

6.2 Original and paper sign
 means a paper with longer length (X) than width (Y).

 means a paper with shorter length (X) than width (Y).
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6.3 Supported originals

Originals available to use in ARDF

Item Specification

Paper type 1side Regular paper (9-5/16lb ~ 34-1/16lb (35g/m2 ~ 128g/m2))

2side Regular paper (13-5/16lb ~ 34-1/16lb (50g/m2 ~ 128g/m2))

Mixed Regular paper (9-5/16lb ~ 34-1/16lb (35g/m2 ~ 128g/m2))

Max original 

size

A3 or Ledger (11 X 17)
Fax: 11-11/16 inch X 39-3/8 inch (297mm X 1000mm)

Original supply Up to 90 sheets(20lb(75g/m2))

  

 - Do not load the following papers to ARDF. When using them, paper jam or damage may occur.

   Wrinkled, folded, rolled or torn originals

   Semi or full transparent originals such as transparent film or direct process paper

   Coated originals such as carbon-backup paper

   Originals lighter than 9-5/16 lb(35 g/m2) or heavier than 34-1/16 lb(128 g/m2)

   Originals combined with staples or clips

   Originals combined as a booklet

   Originals combined with glue

   Originals which are cut or which contain cut-out page

   Label paper

   Offset print master

   Papers under development

   Glossy originals with coating

Originals available to use on flatbed glass

Item Specification

Original type Paper, booklet (with two sides open), post card, 3 dimensional object

Max original size A3 or Ledger (11 X 17)

Weight on flatbed Max 4-7/16 lb(2Kg)
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7. Place original
7.1 Place original in ARDF

ARDF supplies originals, one by one from the page on the top. 
ARDF is convenient to use to make a copy or scan for multiple pages

1  Adjust the original guide in the direction as in the below figure.

2  Face up the side to copy or scan and push the originals until it stop.

  

 - When placing originals, do not place 90 or more pages for a single job.
  Do not exceed the max height of the originals. It may cause paper jam, damage, or malfunction 
  of ARDF.
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3   Adjust the original guide to fit the width of the original.

  

 -  The following originals cannot be used in ARDF.

   Torn or punched original with hole

   Heavily wrinkled or bent original

   Originals stick together due to moisture or static electricity

   Double-side originals by pencil or carbon paper

   Originals made with cloth or metal

   Originals with staple, paper clips or adhesive tape

   Originals stick together with adhesives such as glue

   Glossy papers or special-coated originals
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7.2 Place original on flatbed glass
1  Use the handle of flatbed cover or ARDF to open it.

  When placing original on flatbed glass, lift up the cover or ARDF at least 20° or more.

2  Face down the side to scan and adjust the original to fit the original ruler at the upper left corner of the 
  flatbed glass.
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  3  Use the handle of flatbed cover or ARDF to close it.

  

 -  When there is any original left in ARDF, original on flatbed glass cannot get scanned.

 -  When scanning a thick book or 3-dimensional object, there is no need to close the flatbed cover or ARDF.
  In this case, do not stare at the flatbed glass as it may get very bright. The light from the flatbed glass is not laser  
  beam and not harmful to users.

 -  If there is a sharp edge on the original, it may scratch the flatbed glass.

7.3 Auto-detected original size 
The following originals in standard sizes will be detected automatically.

Item Original size

Flatbed glass Inch : 11”x17”  , Legal , Latter  , Latter  , Statement  

ARDF Metric : A3  , B4  , A4  , A4  , B5  , A5  , A5  , 8K  , 16K  
Inch : Statement  , Statement  , Letter  , Letter  , 112x172  ,Executive ,
          Executive  

7.4 When auto-detection for original size does not work
If the size of original does not get detected automatically, select [From] to configure original. 
For details, see P. 2-3 「1) Originals」.
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If there is no configuration for original size or if the previous setting has not been deleted, the original size from the 
previous setting will apply.

  

 -  If the size of original does not match papers in the tray, supply papers in the same size or change the copy ratio.  
  For details on copy ratio, see P. 2-13 「8) Ratio」.
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8. Papers
8.1 Available papers

Paper type Paper weight Paper capacity

Thin 15-15/16 lb ~ 18-5/16 lb
(60 g/m2 ~ 69 g/m2)

MPT(manual tray) : 100 sheets
Tray1, Tray2  : 500 sheets
Tray3, Tray4  : 500 sheets(optional)

Regular, Recycled
Single special*1
Special*2
Letter head*3
Color*4

18-9/16 lb ~ 23-15/16 lb
(70 g/m2 ~ 90 g/m2)

MPT(manual tray) : 100 sheets
Tray1, Tray2  : 500 sheets
Tray3, Tray4  : 500 sheets(optional)

Thick 1 24-3/16 lb ~ 31-15/16 lb
(91 g/m2 ~ 120 g/m2)

MPT(manual tray) : 20 sheets   
Tray1, Tray2 : 150 sheets          
Tray3, Tray4 : 150 sheets(optional)

Thick 1+ 32-3/16 lb ~ 41-3/4 lb
(121 g/m2 ~ 157 g/m2)

MPT(manual tray) : 20 sheets   
Tray1, Tray2 : 150 sheets          
Tray3, Tray4 : 150 sheets(optional)

Thick 2 42 lb ~ 55-5/8 lb
(158 g/m2 ~ 209 g/m2)

MPT(manual tray) : 20 sheets   
Tray1, Tray2 : 150 sheets          
Tray3, Tray4 : 150 sheets(optional)

Thick 3 55-7/8 lb ~ 58-1/2 lb
(210 g/m2 ~ 220 g/m2)

MPT(manual tray) : 20 sheets   
Tray1, Tray2 : 150 sheets          
Tray3, Tray4 : 150 sheets(optional)

Envelope MPT(manual tray) : 10 sheets

Label MPT(manual tray) : 20 sheets

User paper 1  *5
User paper 2 *5
User paper 3 *5
User paper 4 *5
User paper 5 *5
User paper 6 *5

Thin, Regular, Thick 1,
Thick 2, Thick 3

 *1 Paper not for duplex printing (already printed on one side).
 *2 Premium paper and other special paper.
 *3 Printed paper
 *4 Colored paper.
 *5 Paper registered with frequent use.

  

 -  Papers other than regular papers are called special papers. Set an appropriate paper type when loading special  
  papers into the paper tray. Otherwise paper jam or image error may occur.

  

 -  If you select Thick 3 for your printing, the print quality may be lower than your expectation.

 -  Printing can be done only on the front side of envelope. Print quality on front seal edge cannot be guaranteed. 
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8.2 Available paper sizes

Tray type Available paper size

MPT(manual tray) A3, A4, A5, A6, B4, B5 (JIS), B6, Ledger (11×17), Legal (8-1/2×14), 
Letter (8-1/2×11), Executive(7-1/4×10-1/2), Statement(5-1/2×8-1/2), Foolscap(8×13), 
8-1/8×13-1/4, Folio (8-1/4×13), Government Legal(8-1/2×13), 
8-1/2×13-1/2, 220 mm×330 mm, 8K, 16K photo size  4×6
Width : 3-9/16 inches ~ 12-5/8 inches(90 mm ~ 297 mm),
Length : 5-1/2 inches ~ 17 inches(139.7 mm ~ 431.8 mm)

Tray 1 A4, A5, B4, B5 (JIS), Legal(8-1/2×14), Letter(8-1/2 ×11), Foolscap(8×13), 
Folio(8-1/4×13), Government Legal(8-1/2×13), Statement(5-1/2×8-1/2), 
8-1/2×13-1/2, 16K

Tray 2, 
Tray 3(optional), 
Tray 4(optional)

A3, A4, A5, B4, B5 (JIS), Ledger(11×17), Legal(8-1/2×14), Letter(8-1/2×11),
Foolscap(8×13), Folio(8-1/4×13), Government legal(8-1/2×13), 
Statement(5-1/2×8-1/2), 8-1/2×13-1/2, 8K, 16K

Auto reverse docu-
ment feeder (ARDF)

A3, A4, A5, A6, B4, B5 (JIS), B6, Ledger(11×17), Legal(8-1/2×14), 
Letter(8-1/2×11), Executive(7-1/4×10-1/2), Statement(5-1/2 ×8-1/2), Foolscap(8×13), 
8-1/8×13-1/4, Folio(8-1/4×13), Government Legal(8-1/2×13), 8-1/2×13-1/2, 
220 mm×330mm, 8K, 16K photo size  4×6
Width : 5-1/2 inches ~ 12-5/8 inches(139.7 mm ~ 320 mm),
Length : 5-13/16 inches ~ 18 inches(148 mm ~ 457.2 mm)

8.3 Cautions for proper job

  Papers not allowed
Do not use the following papers in the paper tray. Failure to follow the cautions may result in low print quality, paper 
jam or device damage.

- Printed paper from thermal transfer or ink-jet printer

- Folded, rolled, wrinkled, or torn paper

- Papers left for a long time without packaging

- Wet, holed, or punched papers

- Very slippery, rough, or uneven papers

- Processed paper such as carbon, thermal sensitive, pressure sensitive, or transfer paper

- Foiled or bubble processed paper

- Non-standardized paper (non-quadrangle paper)

- Papers combined with glue, staples, or clips

- Papers with label

- Paper with ribbon, hook, or button

- Paper with different roughness on both sides

- Too thin or thick paper

- Paper with static electricity

-  Acid-processed paper

- Other papers not suitable for use
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Paper storage
Note the followings for proper paper supply.

-  Store papers on a flat surface and do not unpack before it is used. 
 Paper jam may occur if the papers are left for a long time without packaging.

-  When unpacked papers are not used, use the original wrapping to store them in a flat, cool, and dark space.

-  Do not store the papers in the following location or environment.

 Very wet place

 Place exposed to direct sunlight

 Place with high temperature (95 F (35 ℃) or higher)

 Place with dust

- Do not store the papers in other abnormal places. Do not store papers in vertical direction.
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9. Load papers
The following originals in standard sizes will be detected automatically.

Item Original size

Tray 1 B4 , A4 , A4 , B5 , B5 , A5 , 16K , Letter ,

Letter , Legal 

Tray 2, 3, 4 A3 , B4 , A4 , A4 , B5 , B5 , A5 , 8K , 16K , Letter , 

Letter , Legal , 11”x17” 

MPT (Manual tray) A3 , B4 , A4 , A4 , B5 , B5 , A5 , A5 ,  B6 ,

A6 

  

 -  Tray 1 and 2, and Tray 3 (optional) and 4 (optional) support standard sized papers.
  Use the manual paper tray (MPT) to use non-standard paper size.

 -  The paper detected automatically can be vary depending on the setting method.

9.1 Load papers into tray
The same procedure applies when you feed papers to tray 1, 2, 3 (optional), or 4 (optional). The following explains 
how to load papers to Tray 1.

  

 -  After feeding papers to Tray 1, make sure that the paper size and type are properly set for MFP.

1  Pull the handle of Tray 1 to open the tray.

2  Pull or push the paper guide to adjust the papers to feed.
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3  Bend papers back and forth to loosen them and blow them with your breath.
  Do not fold papers or make papers wrinkle. Make sure to sort the papers so that the edge of papers is flat and  
  straight.

  

 - Be careful not to cut your finger by the edge of paper.

 - When papers are bent, make them flat, brush and sort them nicely to load.

4  Face up the side to print and load papers in the tray.
  For available paper sizes, see P. 1-25 「8.2 Available paper size」.

  

 - When loading papers, do not exceed the max height marked in the tray. Too many papers loaded may  
  cause paper jam.

 - Do not mix different paper sizes in one tray.

5  Align the guide to fit the paper size.

6  Close the Tray 1.



1-29

Preparation for using MFP 1

9.2 Load papers to Manual Paper Tray
The manual paper tray is used to load papers of which size cannot be used in Tray 1, 2, 3 (optional), or 4 (optional). 
Also, just like Tray 1, 2, 3, or 4, papers can be loaded in MPT to print automatically.

1   Pull the upper part of MPT to open it.

2  If papers are long, use the extended support to load them.

3  Push the paper guide to spread so that it becomes bigger than the size of paper to feed.

4  Bend papers back and forth to loosen them and blow them with your breath.
  Do not fold papers or make papers wrinkle. Make sure to sort the papers so that the edge of papers is flat and  
  straight.
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5  Face down the side to print and feed the papers inside the paper guide.
  For details on available paper sizes, see P. 1-25 「8.2 Available paper size」.

  

 -  Do not feed too many papers into the MPT not to block the paper guide. 
  Too many papers loaded may cause paper jam.

6  Align the paper guide to fit the paper size.

7  When feeding papers into MPT, the paper setting screen automatically appears on the LCD display. 
  Change paper size and type on the LCD display.
  For details on how to set paper for MPT, see P. 2-5 「When selecting Manual Paper Tray (MPT)」.

① ② ③

 

  ①  MPT Paper setting : Used to manually select paper size when the loaded paper is not detected automatically.
  ② Paper type : You can change paper type. (ex: Envelope, OHP,  Post card, and so on)

  ③ Detected paper : Shows detected paper size to choose from.
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Load post cards
Up to 20 post cards can be loaded at one time.

1  Face down the side to print and load a post card, as in the below figure.

2  Align the paper guide to fit the post card size.

3  When feeding papers into MPT, the paper setting screen automatically appears on the LCD display. 
  If it is not displayed automatically, see P. 2-5 「MPT paper size」.
  Change paper size and type on the LCD display.
  If the post card size to set cannot be found in the paper size list, check the size of post card and enter a size in  
  [Direct input]. For details on direct input, see P. 2-5 「When selecting Manual Paper Tray (MPT)」.

  

 -  To set up for post card, envelope, or OHP film printing, use the [General] tab of the printer driver.
  For details, see [User manual print function].
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Load envelopes
Up to 10 envelopes can be loaded at one time

  

 - Before loading envelopes, remove the air inside the envelope and press the line with cover firmly. 
  Otherwise, it may cause wrinkle on envelope or paper jam.

1  Face down the side to print and load an envelope, as in the below figure.

    - If the cover is on the longer side of envelope, adjust the envelope so that the cover is at the back.

2  Align the paper guide to fit the envelope size.

3  When feeding papers into MPT, the paper setting screen automatically appears on the LCD display. 
  Change paper size and type on the LCD display.
  If the envelope size to set cannot be found in the paper size list, check the size of envelope and enter a size in  
  [Direct input]. For details on direct input, see P. 2-5 「When selecting Manual Paper Tray (MPT)」.
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How to load OHP film properly
OHP film is a transparent film to project and enlarge on a screen. Up to 20 films can be loaded.

1   Face down the side to print and put it in the direction  as in the figure.
Push the film until the edge of OHP film reaches inside.

2  Slide the guide to adjust the size of the paper to load.

3  When feeding papers into MPT, the paper setting screen automatically appears on the LCD display.   
  Change paper size and type on the LCD display.
  If the size to set cannot be found in the paper size list, check the size and enter a size in [Direct input]. 
  For details on direct input, see P. 2-5 「When selecting Manual Paper Tray (MPT)」.
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Load index papers (tab papers)
Up to 20 index papers can be loaded.

1  Face down the side to print, but adjust the paper so that the tab side goes into MFP later. 
  Push the index paper until the edge reaches inside.

2  Slide the guide to adjust the size of the paper to load.

3  When feeding papers into MPT, the paper setting screen automatically appears on the LCD display. 
  Change paper size and type on the LCD display.
  If the size to set cannot be found in the paper size list, check the size and enter a size in [Direct input]. For details  
  on direct input, see P. 2-5 「When selecting Manual Paper Tray (MPT)」.
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10. Connect cables
Connect MFP directly to computers by using USB cables.

  

 - When the device power is on, do not connect or remove any kinds of port.

10.1 Connect USB cable
Users can use a USB cable to connect MFP and standard USB ports are supported.

1  Make sure that the power of all other devices connected to MFP are turned off.

2  Use a USB cable to connect MFP with computer. A USB cable is required to use USB port. 
  Make sure that the USB symbol on MFP matches the symbol on cables.

3  Turn on the power of MFP.
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10.2 Connect network cable
This MFP uses standard network cables to connect directly to the computer network. To connect to the network, 
follow the procedures below.

  

 - Mostly, 100BaseT/1000BaseTX Fast Ethernet port is a standard.

1  Make sure that the power of MFP and all other devices connected are turned off.

2  Use standard cable compatible with user network to connect MFP to LAN or hub.

3  Turn on the power of MFP.
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11. Install MFP Driver
MFP driver makes communication between computer and MFP possible.
MFP drivers include the scanner driver and the printer driver.
This MFP software is usually installed at initial configuration of MFP. If the software needs to be installed after 
configuration, follow the guideline below.

1  Close all open software programs.

2  Insert the CD for the software and the manual.

3  Click on [Install] in the basic installation dialogue window.

4  Follow the instructions on the screen.

11.1 Update options available for printer driver
After installing software and options, you may need to install additional options manually to perform print jobs.

 Window users

1  Click Start on Windows.

  - For Window XP/2003, select Printers and Faxes.

	 	 -	For	Window	2008/Vista,	select	Control	Panel	→	Hardware	and	Sound	→	Printers.

	 	 -	For	Window	7.8/8.1,	select	Control	Panel	→	Hardware	and	Sound	→	Devices	and	Printers.

	 	 -	For	Window	10,	Select	Settings	→	Devices	→	Printers	and	Scanners	→	Devices	and	Printers.

	 	 -	For	Window	Server	2008	R2,	select	Control	Panel	→	Hardware	→	Devices	and	Printers.	
    Or follow the below to open the Printer folder.

  - Click Start and enter control printers in the Run Dialog Box. 
     (You can also press “Windows+R” together to open the Run Dialog Box and enter “control printers”.)

  - Press Enter or select OK to open the Printer folder.

2  Select Sindoh N610_410 MF4000 Series.

3  Right click the mouse on Sindoh N610_410 MF4000 Series.

4  For Windows 7, 8/8.1, 10, Windows Server 2008 R2, and 2012, select [Printer Default Settings] from a   
  corresponding menu.

5  Click [Device setting] tab.

6  Add a device option to install from [Available options]

7  Click [Apply].
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12. Information on Installation and Operation
For more information on installation and operation, refer to the enclosed CD or the website. It explains detailed 
information on the device installation and uninstallation, supply installation and replacement, paper feeding, and CD 
for driver and utility installation.
 

12.1 Driver CD and User Manual
The driver CD includes the printer driver and scanner driver necessary to operate the device. Also, it contains MFP 
utilities, relevant documents and manuals for the device.

12.2 Quick installation guide and user manual
Quick installation guide shows how to install and use the device at a glance. The user manual in the CD provides full 
explanations on the general messages and functions and removal of jammed paper as well as installation and usage 
of the device.

12.3 Sindoh website
You can visit www.sindoh.com to download and update the drivers and utilities, and to find various documents in the 
CD and more information on Multiple Function Printers (MFP).
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1. Make a copy
1.1 Basic operations 
 1  Place an original document to copy on flatbed glass or automatic reverse document feeder (ARDF). For details  
   on how to place an original, see P. 1-19 「7. Place original」.

 2  Select [Copy] on the LCD home screen to switch to the copy mode.

 3  Select copy options needed.

   - Number of copies, documents, papers, document format, document orientation, collate, density, Ratio, combine

   - To use copy options, select [Extended] on the upper right to select a desired option.

 4  On the LCD screen, press -, +, or number key to enter a number of copies.
   You can select a number between 1 and 999. If no number is entered, the default is one.

 5  Select the 【 】  button. The device will start making a copy. A copied side will face down when dispensed.

   - Select the【 】 button to cancel.

   - To reset all copy options:  Select the [ ]button.

1.2 Copying
Default copy screen

▼

   

                                           

1 2 10

3

4 5 6 7 8 9
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 - Factory default settings for copying are as follows:
  Papers: A4 , original type: text/photo, original orientation: 12 o’clock, duplex: 1side-1side, collate: Yes,   
 density: 5, Ratio: 100%, combine: no.

1) Originals
Select type of originals for flatbed or ARDF.

1  Press [From].

2  Select an appropriate original size from the selection screen.

3  If the original is in non-standardized size, select [Direct input] on the LCD screen.
  Select Width or Length on the LCD screen and use the number keys to enter the original size.

▼
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   - For details on how to change units to inch or mm, see P. 7-2 「General setting」.

  2) Papers
  Select a paper tray to print from.
  You can choose paper size and type.

1  Press [Paper].

2  Select a paper tray from the selection screen.
  From your left, [Auto], [Tray 1], [Tray 2], [MPT] are displayed.

  When [Auto] is selected
      -   When Auto is selected for paper, a paper tray will be automatically selected depending on the original size.

 
   - If the size of the original does not match that of papers loaded in any trays, adjust the scale to continue to copy.  
    For details on adjusting scale, see P. 2-13 「8) Ratio」

  When Tray 1 is selected
      -  Tray 1 automatically detects the paper size. For details on papers automatically detected in Tray 1, see P. 1-27  
     「9. Load papers」.
     To change paper type, select [Paper type] and choose a paper type.
     For details on paper size available for Tray 1, see P. 1-27 「9.1 Load Papers to Tray」
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  When Tray 2 is selected
      -  Tray 2 automatically detects the paper size. For details on papers automatically detected in Tray 2, see P. 1-27  
     「9. Load papers」.
     To change paper type, select [Paper type] on the upper right and choose a paper type.
     For details on paper size available for Tray 2, see P. 1-27 「9.1 Load Papers to Tray」.

  When MPT is selected
      -  MPT cannot automatically detect paper size.
     Follow the below procedures to set the paper size and type loaded in MPT.

1  Press [Paper].

2  Load papers. Detect paper size and show it on the screen. Select papers to use.
  - Select [Paper type] when loading papers other than regular papers.
  - Select [MPT paper setting] when loading non-standardized papers.
  - When detected papers and loaded papers are different, select [MPT paper setting] to select papers manually.

3  The below screen appears when [MPT paper setting] is selected. Select papers to use. 
  If the paper to use is not on the selections, press [Direct input] to enter the paper size.
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When [Direct input] is selected, you can manually enter the size of non-standardized papers. 
If you manually enter the paper size, you can save frequently used paper sizes. Enter the width and length of the 
paper by using number keys and select [Regist].
Also, when you save frequently used paper sizes, you can select [Import] to load saved paper sizes. 
Enter a paper size and select [Close].
When you finish with [Direct input], [MPT] on the tray selection screen will change to [Direct input].

4  To change paper type of MPT, select [Paper type] on the upper right and choose a paper type.
  For paper sizes and types available to load in MPT, see P. 1-25 「8.2 Available paper size」.

 
   - For details on how to change units to inch or mm, see P. 1-15 「5.4 Set Units」
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  3) Original type
  After selecting original type, press [Text/Photo].

 - Text: scans original which includes texts only.

 - Text/Photo: scans original with photos, images, and texts.

 - Photo: scans original which includes photos and images only.

  4) Original text orientation
Different copy results will appear depending on how to place originals with longer width or longer length. 
Depending on the text orientation of original, you can select the orientation on the LCD screen.
In basic settings, select [Original Orientation] and select a text orientation. 
The below figure shows how to place original depending on the text orientation.

9 o'clock 12 o'clock

 
   - Duplex copy or combined copy will affect printing orientation.
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  5) Duplex
Original orientation and copy result

  The figures below show the directions of front and back page of copied papers depending on the original text  
  orientation. For details on how to place originals, see P. 1-19 「7. Place original」.
  Papers available for duplex copy are between 60 and 209 g/m2.

Originals Original orientation Copy result

         

12 o’clock

                           

Left to right

                          

9 o’clock

                           

Top to bottom

                          

        

12 o’clock

                          

Left to right

                          

9 o’clock

                           

Top to bottom

                          

           

12 o’clock

                                 

Left to right

                          

9 o’clock

                          

Top to bottom

                          

       

12 o’clock

                           

Left to right

                          

9 o’clock

                          

Top to bottom
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Duplex type

 - “1side original → 1side copy”: 1side original is copied to 1side paper. 

Original text orientation: 12 o'clock

▼

1  In the basic copy screen, select [Original Orientation].

2  Select [12 o'clock].

3  Select [Duplex].

4  Select [1-sided original] from [Duplex].

5  Select [1-sided copy].

6  Select [Close] on the upper right to return to the basic copy screen.

 
   - 1side original and 1side copy are the factory default settings.
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  - “1side original → 2side copy” : Two 1side originals are copied to both sides of a paper.
                                         Original text orientation: 12 o’clock 2side copy: top to bottom

▼

1  In the basic copy screen, select [Original Orientation].

2  Select [12 o'clock].

3  Select [Duplex].

4  Select [1-sided original] from [Duplex].

5  Select [2-sided copy].
  If you want to make the copy flip left to right, select [Top to Top]. 
  If you want to make the copy flip top to bottom, select [Top to Bttm].

6  Select [Close] on the upper right to return to the basic copy screen.
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  - “2side original → 2side copy”: Copy a 2side original to both sides of a paper.
                    Original text orientation: 12 o’clock    2side original:  top to bottom      2side copy: top to bottom

▼

1  In the basic copy screen, select [Original Orientation].

2  Select [12 o’clock].

3  Select [duplex].

4  Select [2-sided original] from [Duplex].
  If you want to make the copy flip left to right, select [Top to Top].
  If you want to make the copy flip top to bottom, select [Top to Bttm.].

5  Select [2-sided copy].
  If you want to make the copy flip left to right, select [Top to Top]. 
  If you want to make the copy flip top to bottom, select [Top to Bttm.].

6  Select [Close] on the upper right to return to the basic copy screen.
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  -  “2side original → 1side copy”: Front and back side of 2side original are copied to two 1side papers.
                                      Original text orientation: 12 o’clock 2side original:  top to bottom

▼

1   In the basic copy screen, select [Original Orientation].

2   Select [12 o’clock].

3   Select [duplex].

4  Select [2-sided original] from [Duplex].
  If you want to make the copy flip left to right, select [Top to Top]. 
  If you want to make the copy flip top to bottom, select [Top to Bttm.].

5  Select [1-sided copy].

6  Select [Close] on the upper right to return to the basic copy screen.
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  6) Collate sort
  Make sets of copies in the page order.  

  7) Density
  Select a number key to select a desired density.

   -  It gets lighter as moving to the left and darker as moving to the right. Default density setting is at 5 out of 9.

   - Auto: MFP scans density of the original and automatically adjusts the density of images.
        Heavy textures of the originals (newspaper or recycled paper) are copied without copying the background.
        If original paper have shades or black image on the front end of the manuscript it can be brighter.

  8) Ratio 
Select position and size of the papers to print.

 - The base point
  The base point for zoom out/in is different depending on the scan method for originals.
  For details on how to place originals on flatbed glass or ARDF, see P. 1-19 「7. Place original」.

 - Auto Scale zooms in/out automatically depending on the original size; Preset Scale zooms in/out according to the  
  scale selected by user.

 - For Preset Scale, user can select from the preset scales or enter any scale user wants.
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  Auto scale

-  For the specified paper size, the scale is automatically adjusted to copy.
    When the original size cannot be detected automatically, 100% scale is used to make a copy.

-  Select [Ratio] - [Auto].
    When scale and paper are set as Auto, the scale will be 100%.

  Change preset scale

-  User can select one of the preset scales to make copy to proper paper.
    Select [Reduce/Enlarge] in Ratio. Select a scale to use and choose [Close].

▼
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  Change custom scale

-  For advanced zoom copy function, you can specify the zoom ratio by 1% in the range of 25%~400%. 
    See the preset scales to properly adjust the ratio.
    For others than preset reduce/enlarge on the LCD screen, select [Direct input]. 
    Use number keys to enter a scale and choose [Close].

▼

  9) Combine
-  Multiple pages can be copied into a single paper.

    The image below shows the result of combined copy when the text orientation is in 12 o’clock, or 9 o’clock. 

       12 o’clock
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            9 o’clock

-  2, 4, 8 original pages can be combined to print on a single paper. (4, 8, 16 pages for duplex copy)

- The scale will be set to “Auto”.

- Some portions in a page may not be copied depending on the size of original and paper.

- When the number of original pages is less than the number of pages set for combined copy, the corresponding  
  page will be left as blank.

- When combine copying four pages, how the combined pages are arrayed will be different depending on the text  
  orientation of originals.
  For details, see P. 2-7 「4) Original orientation」, and P. 2-8 「5) Duplex」.

  1side original

-  Copy two 1side originals into 1 paper
  [Original orientation]-[12 o’clock]-[Combine]-[1-sided original]-[1-sided copy]-[2 → 1]
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-  Copy four 1side originals into a single paper
  [Original Orientation]-[12 o’clock]-[Combine]-[1-sided original]-[1-sided copy]-[4 → 1]

-  Copy four 1side originals into a single paper
    [Original Orientation]-[12 o’clock]-[Combine]-[1-sided original]-[2-sided copy]-[Top to Bttm.] or 
    [Top to Top]-[2 → 1]

-  Copy eight 1side originals into a single paper
  [Original Orientation]-[12 o’clock]-[Combine]-[1-sided original]-[2-sided copy]-[Top to Bttm.] or
  [Top to Top]-[4 → 1]

-  Copy eight 1side originals into a single paper
  [Original Orientation]-[12 o’clock]-[Combine]-[1-sided original]-[1-sided copy]-[8 → 1]
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-  Copy sixteen 1side originals into a single paper
  [Original Orientation]-[12 o’clock]-[Combine Combine]-[1-sided original]-[2-sided copy]-[Top to Bttm.]
  or [Top to Top]-[8 → 1]

  2side original

-  Copy one 2side original on 1side paper.
    [Original Orientation]-[12 o’clock]-[Combine]-[2-sided original]-[Top to Bttm.] or [Top to Top]-
    [1-sided copy]-[2 → 1]

-  Copy two 2side original on 1-side paper
   [Original Orientation]-[12 o'clock]-[Combine]-[2-sided original]-[Top to Bttm.] or [Top to Top]-
   [1-sided copy]-[4 → 1]
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-  Copy two 2-side originals on one 2side paper.
   [Original Orientation]-[12 o’clock]-[Combine]-[2-sided original]-[Top to Bttm.] or [Top to Top]-
   [2-sided copy]-[Top to Bttm.] or [Top to Top]-[2 → 1]

-  Copy four 2-side originals on one 2side paper.
   [Original Orientation]-[12 o’clock]-[Combine]-[2-sided original]-[Top to Bttm.] or [Top to Top]
   - [2-sided copy]-[Top to Bttm.] or [Top to Top]-[4 → 1]

-  Copy four 2-side originals on on 1side paper.
   [Original Orientation]-[12 o’clock]-[Combine]-[2-sided original]-[Top to Bttm.] or [Top to Top]
   -[1-sided copy]-[8 → 1]

-  Copy eight 2-side originals on one 2side paper.
   [Original Orientation]-[12 o’clock]-[Combine Combine]-[2-sided original]-[Top to Bttm.] 
   or [Top to Top]-[2-sided copy]-[Top to Bttm.] or [Top to Top]-[8 → 1]

  10) Additional functions
-   Select additional functions to use more functions other than basic copy functions.

    The additional functions include copy quality, mixed sizes, rotate sort, batch, stamp, watermark, book copy, 
    erase border, B/W reversal, and shift image .
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  Copy quality  

-  Selects the scan resolution of original. When you select High quality, it gives you better print quality but takes  
    longer time to scan. Select either Regular quality or High quality and press [Close] on upper right.

  Mixed sizes: Two originals with same width but with different length can be set together on ARDF.  

-  If mixed sizes are not selected, paper jam may occur or some images may not get copied when two originals with  
    same width but different length are set together on ARDF to copy.

  Rotate sort
-  Copies are rotated in vertical or horizontal direction to sort by each set of copies. However, two paper trays with  

    same size, paper type, but different direction (SEL and LEF) are needed.
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-  Paper size available for rotate sort: A4, A5, B5, Letter, Statement

  Batch 

  -  Up to 90 sheets of originals can be scanned with ARDF at a time. If you want to copy more than 90 sheets of  
   originals, select [Batch] and load 90 sheets or less several times to copy the originals together at a time.

1  Select [ON] for Batch.

2  Select the 【 】 button.
-  When originals are completely transferred, load the next set of originals and press 【 】  button to continue  

   scanning.

3  Select the 【 】 button.
-  After scanning all originals, select  【 】 button to start copying.

Stamp

  -  On upper part of the document, date/page number can be added to copy.
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-  Date: Use the stamp function to select date display type and continue copying.

1  Select [Date]-[Setting].

2  Select the date display type for stamp and press [Setting].

3  Select a stamp location on the above figure.

4  Select either [In every page] or [First Page Only].

5  Press [Close] on the upper right. To add a page number on the stamp, select [Previous]-[Previous].

-  Page number: Use the stamp function to select page display type and continue copying.

1  Press [Page number].

2  Select the page display type for stamp and press [Setting].
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3  Select a stamp location on the above figure.

4  Press [Close] on the upper right.

5  To add a date on the stamp, select [Previous]-[Previous].

Watermark

  Add a text on existing document to copy. For example, a text such as “CONFIDENTIAL” or “URGENT” can be  
  added to page 1 only or to all pages with large and weak density font.
  The device offers default watermarks.

-  For a copy: COPY

-  For preparation: PRELIMINARY

-  For urgency: URGENT

-  For secret: CONFIDENTIAL

-  For priority: PRIORITY

-  For internal use: INTERNAL USE

-  For a draft: DRAFT

Book copy

  Right or left page of originals such as book or catalog with 2 open pages can be copied separately or together.

-  Spread: Originals with 2 open pages can be copied into a 1-side paper.

-  Series: Originals with 2 open pages will be copied by series according to the page numbers.

-  Binding position: When you have selected Series, select the open direction of the original to scan as binding  
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               position. Two-open page originals with left binding, select the left binding, and for two-open  
               pages with right binding, select the right binding. If incorrect binding position is selected, 
               the order of two open pages will be switched.

-  Erase border: Four sides in the frame of the original will be erased with a same margin. Shadows in center will  
           be erased if the flatbed cover is not closed completely due to the thickness of originals.

▼

Erase border

  Four sides of the original will be erased with a same margin. Or top and left sides of the original can be erased  
  separately.

-  Left: Erase the left side of original by a specified margin.

-  Top: Erase the upper side of original by a specified margin.

-  Frame: erase the four sides of original by a specified margin.
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B/W Reversal

  Reverse the darkness or color to copy. When copying an original with dark background, using B/W reversal can  
  save the toner.

Shift image   
  Position of image can be shifted in vertical or horizontal direction for fine adjustment.

-  Left-Right: move an image to the left or right.

-  Top-Bottom: move an image up or down.

Mirorr Image

 Used when copying a reflected, reversed duplication of the document.
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1. Install drivers
When TWAIN or printer driver is installed in computer, this MFP can function as a printer or scanner.
Also, you can insert portable USB memory stick into the MFP to save scanned images or print saved images.

1.1 How to install a driver
Printer/scanner driver makes communication between computer and MFP possible. This printer/scanner software is 
usually installed at initial configuration of MFP.
If the software needs to be installed after configuration, follow the guideline below. Read the instructions written 
inside the installer to install it.

1  Close all open software programs.

2  Insert the CD.

 
 - Follow the installation instructions in the window and wait for a while, if Net Framework 2.0 or higher is  
  not installed. The Net Framework will be installed automatically. 

3  Click [Install Driver and Utility] in Software and Manual.

4  Select an installation type and click [Next>].
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  USB attached

    - When USB attached is selected, default printer and scan driver are installed. 
     After installation, you can print and scan by using USB.

    - Follow the instruction for device connection and click [Next>].

  Network attached (recommended installation)

    - When network installation is selected, default printer and scan driver are installed.
     After installation, you can print and scan by using the network.

    - Enter IP address and port name and click [Next>].
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1.2 Update options available for printer driver
After installing printer software and options, you may need to install additional options manually to perform print jobs.

 Window users
1  Click Start on Windows.

  - For Window XP/2003, select Printer and Fax.

  - For Window 2008/Vista, select [Control Panel] → [Hardware and Sound] → [Printers].

  - For Window 7.8/8.1, select [Control Panel] → [Hardware and Sound] → [Devices and Printers].

  - For Window 10, Select [Configuration] → [Device] →  [Printer and Scanner] →  [Device and Printer].

  - For Window Server 2008 R2, select [Control Panel] → [Hardware] → [Devices and Printers]. Or follow the 

  below to open the Printer folder.

  -  Click Start and enter ‘control printers’ in the Run Dialog Box.
   (You can also press “Windows+R” together to open the Run Dialog Box and enter ‘control printers’.)

  -  Press Enter or select OK to open the Printer folder.

2  Select Sindoh N610_410 MF4000 Series.

3  Right click the mouse on Sindoh N610_410 MF4000 Series.

4  For Window XP/2003/2008/Vista, click [Printer Default Settings].
  For Windows 7, 8/8.1, 10, Windows Server 2008 R2, and 2012, select [Printer Default Settings] from a   
  corresponding menu.

5  Click [Device setting] tab.

6  Add a device option to install from [Available options].

7  Click [Apply].
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2. Print from computer
After installing printer driver, you can print documents with this MFP.

2.1 Print
How to print documents vary depending on the driver settings of user printer. For details, see How to set printer driver 
configuration.

1  Open a document with application program.

2  Select [Print (P)] on the “File” menu.

3  Make sure that the printer driver for MFP is selected.

4  If necessary, open “Preferences” to select options.
  “Preferences” may appear as “Properties” in some applications.
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5  Select [Print (P)] to start printing.

2.2 Use control panel button to cancel printing
This section explains how to cancel printing job from the control panel of MFP.

1  Select [Job manager] on the LCD home screen to switch to the job manager mode.

2  Select a job to cancel from the job list and press [Cancel].
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2.3 Cancel print job from computer
Cancel print job from computer

1  Click [Start].

2  Select Control Panel.

3  Select Devices and Printers.
  The list of printers installed will be displayed.

4  Double click a printer currently working or select a printer currently working and choose
  “View printing job list” on the top. 
  The list of printing job will appear.

5  Select a job to cancel.

6 	 To	cancel	all	printing	jobs	on	the	list,	select	Printer	→	Cancel	All.	
  To cancel a certain printing job, select the job to cancel and right click the mouse to select Cancel or select  
	 	 Document	→	Cancel
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3. Print with portable USB memory
You can print documents by inserting a portable USB memory into the MFP.

3.1 Print
1  Insert a portable USB memory into the device.

 
 - An error may occur if the USB device is removed during reading the USB memory or printing/scanning  
  with the USB device.

2  Select [Storage] from the LCD home screen.
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3  The LCD shows printable files or folders in the USB memory.

4  Select a file to print (available file extensions: *.jpg, *.pdf, *.tiff, or *.png)

5  When a file is selected, the preview screen will appear (only for *.jpg, *.jpeg, or *.png)

6  When you select [File print], the screen for copy opens.

7  See「Chapter 2. Copy functions」 in the manual to finish configuration and select 【 】 button to print a file in the  
  USB memory.
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4. Configure printer driver setting
Open the printer registration information and select a print option.

4.1 Open printer registration information
There are two methods to open printer registration information.

  - Open from application program

  - Open from “Printer” folder.

If you change printer registration information from application program, it only applies to current printing jobs.
If you want to change the default settings for printer, select the “Printer” folder to change it. 
This change applies to all users sharing the printer.

Change software settings from application program
How to open printer registration information window varies depending on the application program. 
See the user manual of the application program you are using. 
Let’s take “Notepad” in Windows for example.

1  Select [Print] on the “File” menu.

2  Click a printer from Select Printer and select [Default settings].

3  The “Print default settings” window appears.
  For details on configuration of printer driver, see the common options in each tab.

Configure from “Printer” folder
To change the printer driver setting, you must log on as Administrator.

1  Follow the below procedure to run [Devices and Printers] or [Printers or Faxes].

  - For Windows 7 or 8/8.1, select [Start] → [Control panel] → [Hardware and sound] → [Devices and printers].

  - In Windows 10, select [Configuration] → [Device] → [Printer and Scanner] → [Device and Printer].

  -	 For	Windows	Vista	or	Server	2008,	select	[Start]	→	[Control panel] → [Hardware and sound] → [Printers].

  - In Windows XP Professional, click [Start] → [Printers and Faxes].

  - In Windows XP Professional edition, click [Start] → [Control Panel] → [Printers and other hardware] → 
   [Printers and Faxes].

2  Right click the icon of installed printer and click [Print default settings].

3  The registration information window of printer appears. 
  For details on configuration of printer driver, see the common options in each tab.
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4.2 Common options in each tab
This section explains the functions of common option buttons in each tab.

① ② ③⑥

④

⑤

  ① [OK]

   Applies all changes and exits the “Registration information” dialog box.

  ② [Cancel]

   Does not apply any changes; exits the “Registration information” dialog box.

  ③ [Help]

   Shows the Help window.

  ④ [Restore]

   Resets all settings in the current tab and restores all default values, or resets to user default settings.

  ⑤ [Settings summary]

   Shows the current settings for the printer driver.

  ⑥ [Apply]

   Saves the changes in settings and you can continue to change other options.
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4.3 Print setting tab
In the “Print setting” tab, you can select your choice for “job type”, “copies”, “orientation”, “duplex”, or “pages per 
sheet”.

①

②

③

④

⑤

  ① [Job type]

   The driver gives you an option to select a job type.
   Job types available are Normal Print, Sample Print, Locked Print, Locked Print(Save), and Stored Print. 
   To use options other than Normal Print, you must know the certification information in Advanced tab of the file and
   you must enter a correct user code or ID/password into the MFP. If the information does not match, printing cannot  
   proceed. For details on how to input certification information, see P. 3-27 「⑤ Enter certification information」.
   Normal Print, Sample Print, Locked Print, Locked Print(Save), and Stored Print are displayed only when the printer  
   driver port is connected to an IP. For details on how to select options on LCD screen for each job type, 
   see Chapter 7 「Additional functions」. 

 
 - The print options other than regular print may not work properly in some application programs.
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   Details

  Normal Print

    Use this option to process normal and regular printing job. This option is set by default for printer driver.

  Sample  print (rotate print cannot be used together)

    - Sample print always prints out one copy only.

  - This function is used to print out only one copy to check if there is any mistake in contents or option selection.

  - When the Sample print function is used, the scanned original is saved in the MFP.

  - User can select a scanned original saved in the MFP.

  - After checking a single copy of the Sample print, user can select to make more copies or cancel the job  
   depending on the result of the Sample print.

  - If the Sample printed file is printed or cancelled, the saved original in MFP will be automatically deleted.

  Locked print (rotate print cannot be used together)

    - Use this function to maintain security when printing a document with MFP via shared network.

    - When the Locked print function is used, the document does not get printed right away, but the contents in file  
     are saved in MFP temporarily.

    - Then user can select a temporary file to print in MFP

    - If user code or ID/password is set for the document, it must be correctly entered to process the print job.

    - This function allows user to print the document only one time.
     After it is printed, the temporary file saved in MFP is automatically deleted.

  Locked print (rotate print cannot be used together)

    - Use this function to maintain security when printing a document with MFP via shared network.

    - When the Locked print function is used, the document does not get printed right away, but the 
     contents in file are saved in MFP.

    - User can select a scanned original saved in the MFP.

    - If user code or ID/password is set for the document, it must be correctly entered to process the print job.

    - This option allows user to print the document several times as long as the file is saved in MFP.

  Stored print (rotate print cannot be used together)

    - Use this function to maintain security when printing a document with MFP via shared network.

    - When the Stored print function is used, the scanned original is saved in the MFP.

    - To make more prints for the same file, user can select the saved file in MFP to print out more.

    - User can select a scanned original saved in the MFP.

    - If user code or ID/password is set for the document, it must be correctly entered to process the print job.

    - This option allows user to print the document several times as long as the file is saved in MFP. 
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   “Details” 

    - User can set a name and password for the file box to save files in MFP.

  ② [Copies]

   User can select a number of printout pages. Print by sets and rotate print are available to select. 
   To change the following print settings, open the print default setting page and click the print setting tab.

   Details

  Copies

    User can choose a number of prints to make. Use the up or down arrow to adjust the Copies.

  Collate

    - If the check box is not selected, printer will make copies for each page. 
     For example, when there are 3 pages to copy and user selects 2 for the number of prints, 2 copies for the 
     first page, 2 copies for the second page, and 2 copies for the third page are printed out.

    - When “Collate” is selected, a set of copies (page 1, 2, and 3) is printed first, and then the next set of copies  
     (page 1, 2, and 3) is printed. Selection in application supersedes any settings to make this function available.

  Rotation Sort

    User can use this Rotation Sort function to print out the even pages after they are rotated at 90 degree. 
    To use this function properly, refer to the restrictions and cautions below.

    <Restrictions and cautions>

    - Rotation Sort can be used for papers in the following sizes: A4, B5, Letter, Executive, A5, Statement, and 16K.  
     (Available only for paper sizes which can be loaded both in the T and Y direction to the manual tray.)

    - Not for front/back page, and inserting page.

    - Paper orientation must be proper for each paper tray.
     (Must load papers at 90° in manual paper tray or A3 paper tray if 90° rotation is desired.)

    - Sample Print, Locked Print, Locked Print(Save), and Stored Print cannot be used together.

    - This function may not work properly with a certain application program.
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  ③ Orientation

   User can select the print orientation for the page. When “Portrait” is selected, the shorter side of paper is located 
   on the top.
   When “Landscape” is selected, the longer side of paper is located on the top. Most applications offer the 
   “Page setting” option to select paper orientation, which supersedes this setting. User can select Rotate 180 to have  
   the printed papers rotate 180° when they are dispensed.
   To change the following print settings, open the print default setting page and click the print setting tab.

  ④ [Duplex]

  [Duplex]

    Both sides of paper can be printed when this option is selected. Before printing, the binding position of papers  
    must be selected. (Papers available for 2-booklet can be used.) To change the following print settings, open the  
    print default setting page and click the print setting tab.

  <How to use>

   - Select a desired binding direction.

Figure Binding direction Description

No(Simplex) Single-sided (regular) print is available.

Long Edge Usually for book type print. 
(User can flip pages at longer side of paper)

Short Edge Layout usually used for calendar.

   - Click the paper tab and choose appropriate original size, print image size, and paper type.

   - Click OK or Print to exit the print page.
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  [Booklet print]

    Use this option to print on both sides of papers and arrange papers to bind them together to make a booklet.
    The following papers can be used only to make a booklet. (Letter, Legal, Statement, Executive, A3, A4, A5, A6,  
    B4, B5, B6, 11x17, 8x13, 8.25x13, 8.5x13, 8.5x13.5, 8.65x13, 8.125x13.25, 4x6, 8K, 16K)
    To change the following print settings, open the print default setting page and click the print setting tab.

  <How to use>

   - Select the print setting tab and choose 2 - Booklet in Pages per Sheet.

   - Click the paper tab and choose appropriate original size, print image size, and paper type.

   - Click OK or Print to exit the print page.

   - After printing, fold the papers in half to bind them together (or cut them off in half to bind).

   - When Right Binding is selected, the pages will be printed to make flipping pages to right look proper.

   - Signature Pages increase by 4, and the number of pages entered will be grouped into a page to print.
    For example, when 10-page document is printed with the signature page value of “4”, page 1 through 4, page 5  
    through 8, and page 9 through 10 will be printed in each page.

  ⑤ [Multipage print]

   User can choose a number of pages to print on one-side of a single page. When actual number of pages is less  
   than the number of pages entered, the corresponding portion will be shown as blank. Booklet is a specified format  
   with 2 pages on each paper. When booklet is selected, the pages will be sorted in the same order as a flipping  
   booklet folded in half. To change the following print settings, open the print default setting page and click the Print  
   setting tab.

   Details

  Select the number of pages per sheet

    User can select the number of pages per sheet (1 page, 2-booklet, 2 pages, 4 pages, 6 pages, 8 pages, 9 pages,  
    or 16 pages).
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  Page Layout

    - When selected, the pages with multipage print will have borders.

  First page - Layout

    - User can select the location starting from page 2. For page 2, it can be located at left/right or top/bottom.

    - From page 4 to 16, it can be located in a row (upper/lower left), or column 
     (upper/lower left).

    - After printing, fold the papers in half to bind them together (or cut them off in half to bind).

                                                       (Selection for page 2)             (Selection for page 4 through 16)

4.4 Paper tab
In the “Paper” tab, user can select options for “original size”, “print image size”, “custom”, “zoom”, “paper tray”, 
“media type” and “more input option”.
To change the following print settings, open the Print Default Setting page and click the Paper tab.

①

③

②
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  ① Print On [Print image size]

   User can use this option to print paper by resizing the original to fit in the paper. User can select either 
   “Scale To Fit” or “Center” to print paper as needed.
   To change the following print settings, open the Print Default Setting page and click the Paper tab.

  ② Zoom [Scale]

   User can select Scale to reduce or enlarge the original to print.
   Direct input into the scale box is possible or user can use the left/right arrow to adjust the scale. When “Center”  
   is selected, the original is printed on the center of the paper. The scale option in the PDL printer driver cannot be  
   used with “Poster” in the advanced tab. To change the following print settings, open the Print Default Setting page  
   and click the Paper tab.

  ③ [Additional option]

   Options such as “Front cover”, “Back cover”, “Inserting paper”, “Margin” and “Push in Binding” are available.
   To change the following print settings, open the Print Default Setting page and click the More Input Options button.

   Details

  Front/Back Covers

    - For the front cover, user can select a paper tray and paper type.  The front cover is printed only on a single  
     page. For the front cover, user can select “blank cover” or “printed cover”. 
     The front cover option cannot be used with rotate print, duplex print, poster print, or booklet print.

    - For the back cover, user can select a paper tray and paper type. 
     The back cover is printed only on a single page.
     For the back cover, user can select “blank cover” or “printed cover”. 
     The back cover option cannot be used with rotate print, duplex print, poster print, or booklet print.
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  Interleave Pages

    - An interleave page is printed only on a single page.

    - User can select this option to add additional page between each print job.

    - For An interleave page, a different paper type or different paper tray can be used.

    - An interleave page can be a blank page or duplicate page.

    - The paper size for An interleave page must be as same as the one for printing job.

    - The An interleave page option cannot be used with rotate print, duplex print, poster print, or booklet print.
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  Margins

    - User can modify options for a minimum margin. Select “Printer Margins” to use the default margin or select  
     “Margins” to use user specified margin. User set margin cannot be narrower than the printer’s default   
     margin. When “2 - Booklet” is set as “Multipage print” in the paper tab, the custom margin cannot be used.

    - custom margin cannot be modified directly from the document to print.
     It can be modified only in “Print default setting” in [Printers & Faxes] or [Devices and Printers].
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4.5 Functions in “Advanced” tab
In "Advanced" tab, options such as "Poster Print", "Watermarks", "Overlays", "More Options", "Valid Access ", or 
"Settings" are available. To change the following print settings, open the print default setting page and click the 
Advanced tab.

①

②

③

④

⑤

⑥

  ① [Poster Print]

   When user selects “Poster Print”, a print job is enlarged into several paper sheets. 
   User can arrange these several paper sheets to complete a large size poster. If any other options such as front  
   cover, back cover or inserting page (front/back cover) are used to print at least one page or more, the poster print  
   option cannot be used. Also, the scale option in the paper tab can be 100% only.
   Using this option gives user an option to complete a large poster by arranging 4, 9, 16, or 25 sheets.

  <How to use>

   Select a desired page layout (available layout)

    - 2×2:  a page is enlarged into 4 sheets.

    - 3×3 : a page is enlarged into 9 sheets.

    - 4×4:  a page is enlarged into 16 pages.

    - 5×5:  a page is enlarged into 25 pages.
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  ② [Watermarks]

   User can select this option to print a text on existing documents.
   For example, a text such as “Confidential” or “Internal Use Only” can be added to page 1 only or to all pages with  
   large and weak density font.
   The device offers several default watermarks. 
   The default watermarks can be edited or user can add a new watermark.

  <How to use>

  Use default watermark

    - Select a desired watermark to use from the list. 
     In the preview image, user can view the selected watermark.

    - Click OK or Print to exit the print page.

  Make a new watermark

    - Select “New” in the watermark window.

    - A window for new water mark type appears. In this window, you can use either text string watermark or bitmap  
     image watermark.
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    - Watermark text: In the Watermark text box, you can enter a text to use. 
     In the preview pane, you can view an entered text.
     For font, you can choose options for your text watermark including bold, italic, outline, size, angle, darkness,  
     and offset starting point.

    - Bitmap Image Watermark: You can create a name for watermark, choose a bmp file, adjust scale, and change  
     the offset starting point (page center, tile, fit to page) to create a new bitmap image watermark.

    - Click Add to add a new watermark to the watermark list.

    - After finishing all changes, click OK or Print to exit the print page.
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  Edit watermark

    - Select a watermark and click “Edit” in the “Available watermarks” list. 
     A screen to edit watermark appears (refer to the watermark list screen).

    - Select a watermark to edit from the watermark list and change watermark text message and other options.

    - Click Apply to save the changes.

    - Click OK or Print to exit the print page.

  Delete watermark

    - Select a watermark and click “Delete” in the “Available watermarks” (refer to the watermark list screen).

    - Click OK or Print to exit the print page.

  Select to apply watermark

    - All pages: Apply existing or new watermark to all pages.

    - First Page Only: Apply existing or new watermark to the first page only.

    - First Pages/Other Pages: Apply different watermark, existing or new, to the first page or to other pages.

    - Odd Pages/Even pages: Apply different watermark, existing or new, to odd number pages or to even number  
     pages.

 



3-25

Printer 3

  ③ Use [Overlay Function] 

   Overlay can be saved in the hard disk drive and added on a document to print. 
   Overlay is usually used instead of styled papers. Instead of using styled papers already printed, user can use an  
   overlay as same as the styled paper. User can add an overlay to document to print instead of using styled paper.

  Create a new overlay: To use an overlay, user can create a new overlay in a desired style.

    - Open a file to create an overlay (meaning original document to place an overlay).

    - To change print settings from application program, open a print default setting screen.

    - Click the Advanced tab to select a desired overlay to use from the list.

    - Click Overlay dropdown list and select Create New Overlay.

    - Click Directory as to select a directory to save the overlay and select Print.
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   Save location 

       (Ex: enter “C:\” to save in the drive C. A new overlay is created in C:\.)

    - A window to create a new overlay appears when you click OK. 
     In description, enter details to describe an overlay and check the overlay file name. Then click OK. 
     (Ex: the file name in the figure is 005AD859.OVL.)

    - Then print a document to create an overlay.

    - An overlay is created in the path.

     Use overlay 

    - Open an original document to overwrite a created overlay.

    - When you open the overlay function, overlays previously created are displayed.

    - In the Overlay Select list, choose an overlay to use and click OK. Click Properties to view properties of the  
     overlay. User can delete it or find the path where it is saved. If there are more than 2 overlays, user can  
     choose different overlays for each page.

    - Click OK or Print to exit the print page.
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 ④ [More Options]

   User can open a window to configure additional options. 
   In additional options, you can find “Fonts”.

   Details

    - Fonts: select it to choose options for fonts.

		 ⑤	[Valid Access]

   Use “Valid Access” to validate user code or limit access by other users. 
   Select [Printer driver] → [Properties] → [Advanced option] to choose the valid access. 
   If it is not selected, validation information in default print setting for printer driver cannot be entered.

																																																													<Default	print	setting	→	Advanced	Options	→	Authentication>

	<Printer	driver	properties	→	Advanced	Options>
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  ⑥ [Settings]

   You can save the current printer settings, restore the previous settings, or reset all printer settings.

4.6 Print Quality tab         
  This tab includes options such as “Resolution”, “Print Text Black”, “Halftoning”, “Correction”, “Toner Save”,   
  and “Toner Darkness”. To change the following print settings, open the print default setting page and click the Quality  
  tab to select buttons.

①

②

③

④

⑤

⑥

  ① [Resolution]

   User can select different resolutions for printing job. This option gives a print resolution in dots per inch (DPI or dpi).  
   Higher resolution offers better printing quality but it takes longer to send the print job to the printer and to process  
   the print job. Higher resolution requires more memory. When you get an error message, “out of memory”, lower  
   resolution must be selected.
   User can choose 600 dpi, or 1,200 dpi.
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  ② [Print Text Black]

   Regardless of font colors selected in the application, all texts can be printed in black.

  ③ [Halftoning]

   The Halftoning function applies only to PCL5e driver. 
   Types of the half tone include “Standard”, “Rough”, “Line art”, or “None”.

  ④ [Grey Correction]

   The grey Correction function can be used only in the Raster mode of PCL5e. 
   Contrast and darkness of the print job can be adjusted.
   Brightness and contrast can be adjusted by user setting. Default value is 0 for brightness and 1 for contrast.

  ⑤ [Toner Darkness]

   User can control the toner darkness for printing.

  ⑥ [Toner Save]

   User can use this option to save toners used in printing.
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4.7 Device Options tab 
  In the “Device Options” tab, user can find view “Installable Options” and “more information”.

①

②

  ① [Installable Options]

   User can find options available to install in MFP and view information of options already installed.

  ② [About]

   User can find printer driver information installed.
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1. How to install a driver
When TWAIN or printer driver is installed in computer, this device can function as a printer or scanner.
Also, you can insert portable USB memory stick into the MFP to save scanned images or print saved images. Printer/
scanner driver makes communication between computer and MFP possible.
This printer/scanner software is usually installed at initial configuration of MFP. If the software needs to be installed 
after configuration, follow
the guideline below.

 1  Close all open software programs.

 2  Insert the CD for the software and the manual.

 3  Click on [Install Printer Driver and Software] in the basic installation dialogue window.

 4  Follow the instructions on the screen.
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2. Scan a document with computer
After installing TWAIN driver, you can scan documents with this device.
By using applications installed in your computer, you can edit or process scanned images.

2.1 Scan a document with computer
 With TWAIN driver compatible applications, you can scan a document and send it to computer.

 1  Run the TWAIN compatible program.

2  Scan the document using the application program. Scanning procedures vary depending on user’s program. 
  For more information, refer to the program manual.

 3  Select a scanner device.
  Click “SINDOH N410 N610 Series TWAIN” if you are using a USB cable to scan. 
  Select “SINDOH N410n N610n Series NETWORK TWAIN” if you are using a network cable to scan.

 4  Configure the settings for scanner driver.
   See the [Scan driver setting menu] table below for details.

 5  If you want to scan a portion of document, select [Preview] in the scanner driver to scan in a low resolution. To  
   scan the whole document, go to the step  7  .

 6  Select a desired scanning area in the preview window.

 7  Press [Scan] button to start scanning.

 8  The scanned image is transferred to the application program.
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<N410 N610 Series TWAIN Driver>

<N410n N610n Series Network TWAIN Driver>
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 Scan driver setting menu

Setting group Menu Options Descriptions

*Scanner Edit Add, delete Add or delete IP address.

Scan Source Flatbed, ARDF, Duplex Select to place originals.

General Normal 
(Grayscale)

Advanced: grey, resolution 300×300 dpi (auto)

Photo (Color) Advanced: color, resolution 300×300 dpi (auto)

Document 
(Black/White)

Advanced: grey, resolution 300×300 dpi (auto)

Custom Select customized settings for scanning.

Scan Size A6, B6, Statement, A5, 
B5, Excutive, 16K, A4, 
Letter, 
Folio, Legal, B4, 8K, 
11x15, Ledger, A3 etc.

Select a desired size for scanning.

Orientation Longer side The longer side of original is placed on the document 
feeder.

Shorter side The shorter side of original is placed on the document 
feeder.

Advanced Color type B/W Texts and images in original are displayed in black 
and white.

Grey Texts and images in original are displayed in grey.

Color Texts and images in original are displayed in color.

Resolution 150dpi, 200dpi,
300dpi, 600dpi

Scan original with the selected resolution.

Half tone 
mode

Threshold Show images simply in black and white.

Error Diffusion Show images simply in dots.

Brightness -100 ~ 100 Scan original with the selected brightness.

Contrast -100 ~ 100 Scan original with the selected contrast.

Push scan Scan document by using the device control panel.

Preview Drag the area setting on the upper right to select a 
desired area and scan image in advance to view.

Scan Start scanning.

Exit End scanning.

Version Show the version information of the driver.

 * : Applies only to network scanner driver
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3. Scan
The below explains how to scan an original. User can scan by either using the automatic reverse document feeder 
(ARDF) or flatbed glass.

3.1 Use the automatic reverse document feeder

 1  Adjust the original guide in the direction as in the below figure.

 2  Face up the side to copy or scan and push the originals until it stop.

 
  - On the document feeder, do not place 90 or more pages for a single job. 
   And do not exceed the max height of the originals. 
   It may cause paper jam, damage, or malfunction of ARDF.
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 3  Adjust the original guide to fit the width of the original.

3.2	 Use	flatbed	glass

 1  Use the handle of flatbed cover or ARDF to open it.
   When placing original on flatbed glass, lift up the cover or ARDF at least 20° or more.

 2  Face down the side to scan and adjust the original to fit the original ruler at the upper left corner of the flatbed  
   glass.
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 3  Use the handle of flatbed cover or ARDF to close it.



4-9

Scanner 4

4. Scan setting
 Please follow the procedure below to change scan setting.

 1  Place an original document on flatbed glass or automatic reverse document feeder (ARDF).

 2  Select [Scan] on the LCD home screen to enter the scan setting mode.

 3  Select a resolution of the document to scan on the LCD screen.
       User can select a value between 150 DPI and 600 DPI for the resolution.

 4  Select a size of the document to scan on the LCD screen.
  If an original is in standard size, the size will be detected automatically.
  For details on standard sized originals, see P. 1-22 「7.3 Auto-detected original size」.
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▼

 If an original is not in a standard size, select “Direct input” to select the size manually. 
 For details on direct input, see P. 2-3 「1) Originals」.

 Select a size of original and select [Close].
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 5  Select [Save as] on the LCD screen.
  Select a file format to save and press [Close].

      ▼

     

 6  User can scan a 2side original.
   To scan a 2side original, select [Duplex] and choose either [Top to Top] or [Top to bottom].

      ▼
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 7  You can select a type of original to scan.
   Select [Color/BW] and select a color mode to scan the original. 
   For details on type of color modes, see the explanations below.

      ▼

     

 [Color]: an original gets scanned in full color, regardless of the colors in original.

 [Gray]: an original gets scanned in grey color, regardless of the colors in original.

 [B&W Text]: an original gets scanned in black and white. To scan an original with texts, use this option.

 [B&W Photo]: an original gets scanned in black and white. 
 To scan an original with images and photos, use this option.
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5. Scan to send
 User can scan an original and send the image of it. Available options include “Send by mail”, “Send to shared folder”,  
 Send via FTP” and “Send to WebDAV server”.

 

  - At the same time, you can transfer up to 10 places.
  - You can check the destination by pressing the Dest.

5.1 Send by mail
 Scanned files can be sent in an email. The SMTP server must be configured to use this option. 
 For configuration details, see P. 7-8 「1.2 Network setting」.

 1  Select [Scan] on the LCD home screen to enter the scan setting mode.

 2  Place an original document on flatbed glass or automatic reverse document feeder (ARDF).

 3  Select [E-Mail].
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 4  Fill out the field for [Receiver], [Cc], [Title], [Message] on the LCD screen.
   Direct input or selection from Contacts is available to fill out [Recipient] and [CC].
   If [Recipient] is registered in Contacts, find and select an email address from the list. 
   You can select multiple recipients.

      ▼

 5  You can add or delete [Receiver] or [Cc].
   “;” can be used to separate each e-mail address for direct input and to add more email addresses.

 6  Press [Close] when finished.

 7  Select 【 】button to scan an original. Then the scanned image is sent to the email address selected.
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5.2 Send via FTP
 Scanned images can be sent to the FTP server.

 1  elect [Scan] on the LCD home screen to enter the scan setting mode.

 2  Place an original document on flatbed glass or automatic reverse document feeder (ARDF).

 3  Select [FTP].

 4  Fill out the field for [Address], [Path], [ID], [Password], and [Port] on the LCD screen.
   Direct input or selection from Contacts is available to fill out [Address].
   When address is registered in Contacts, find and select a desired address.
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 5  Select [Conn test] to check the connection. If connection is unsuccessful, the FTP cannot be connected.   
    Enter a new address or select [Delete]. When checking connection is finished, press [Close].

 6  Select 【 】 button to scan the document and then the image is sent to the FTP.

5.3 Send to shared folder
 Scanned images can be sent to the shared folder.

 1  Select [Scan] on the LCD home screen to enter the scan setting mode.

 2  Place an original document on flatbed glass or automatic reverse document feeder (ARDF).

 3  Press [SMB].
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 4  Fill out the field for [Address], [Path], [ID], [Password], and [Port] on the LCD screen.
        Direct input or selection from Contacts is available to fill out [Address].
    When address is registered in Contacts, find and select a desired address.

 5  Select [Conn test] to check the connection. If connection is unsuccessful, the shared folder cannot be 
   connected. 
   Enter a new address or select [Delete]. When checking connection is finished, press [Close].

 6  Select 【 】 button to scan the document and then the image is sent to the shared folder.
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5.4 Send to WebDAV
 This option can serve as network drive by using a web server.

 1  Select [Scan] on the LCD home screen to enter the scan setting mode.

 2  Place an original document on flatbed glass or automatic reverse document feeder (ARDF).

 3  Press [WebDAV].

 4  Fill out the field for [Address], [Path], [ID], [Password], and [Port] on the LCD screen.
        Direct input or selection from Contacts is available to fill out [Address].
    When address is registered in Contacts, find and select a desired address.
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 5  Select [Conn test] to check the connection. If connection is unsuccessful, the WebDAV cannot be 
   connected. Enter a new address or select [Delete]. When checking connection is finished, press [Close].

     

 6  Select 【 】 button to scan the document and then the image is sent to the WebDAV.
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6. Save files
 You can save scanned documents in a USB memory.

 1  Select [Scan] on the LCD home screen to enter the scan setting mode.

 2  Place an original document on flatbed glass or automatic reverse document feeder (ARDF).

 3  Insert the USB memory as in the figure below.
   After inserting USB memory, press [Scan] button on the screen.

 4  Press [USB].
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 5  Enter [File name] and select [ ] in [Save in] to choose a location to save file.

 6  Press 【 】 button to scan the original and the scanned image is saved in the USB memory.

 
  -  A scanned file is saved as a filename, “YYYYMMDD_HHMMSS_number”. 
   User can manually enter filenames except the number.

6.1 Scan Settings

             Item 
Menu              

Description Options

Color/BW Select color type for scan images. Color, *grey, B&W text, B&W image

Resolution Select resolution for scan images. 150DPI, 200DPI, *300DPI, 600DPI

From Select size for original to scan. *Auto, A6, A5, B6, B5, A4, B4, A3, Statement, 
Executive, LT, Legal, 11”x17”, 16K, 8K, 
Custom, etc

Save as Select file format to save image files. JPEG, TIFF, *PDF, secure PDF 1)

Scan density Select brightness of scan images. 1 ~ 9, default : 5 

  * : factory default settings
 1)  Permission password (required) and document password must be set.
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7. Additional functions
 In Additional functions, the following options are available: scan density, original text orientation, JPEG quality, Erase  
 border, Mixed size, Batch, etc.

7.1 Scan density

 1  The scan density can be adjusted as needed.
   Select [Scan]-[Extended]-[Scan density] on the LCD home screen and select density. 
   It gets lighter as moving to the left and darker as moving to the right.
   Default density setting is at 5 out of 9.

7.2 Original Orientation

Use this function to select orientation of text in original. The default value is 12 o’clock.
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7.3 JPEG quality

 1  User can select JPEG quality for scanned document. 
        Select [Scan]-[Extended]-[JPEG quality] and choose a quality.

7.4 Erase border
 User can select this option to give margins to borders in scanned paper, like a frame.

 1  On the LCD home screen, select [Scan]-[Extended] - [Erase border].

 [Same width]: erase the four sides of original by the same specified margin.

          [Individual width]: erase the four sides of original by each different margin.

          [Center width]: Erase shadows in center if the flatbed cover is not closed completely due to the thickness of   
 originals.
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7.5 Mixed sizes:
 Two originals with same width but with different length can be scanned together on ARDF.

 If Mixed sizes is not selected, paper jam may occur or some images may not get scanned when two originals  
 with same width but different length are set together on ARDF to scan.

 1  Place an original on flatbed glass or automatic reverse document feeder (ARDF).

 2  Select [Scan]-[Extended]-[Mixed sizes] on the LCD home screen and select Yes.

7.6 Batch
 Use this function to scan originals in a batch.

7.7  Book scan
Right or left page of originals such as book or catalog with 2 open pages can be copied separately or together.

- Spread: Originals with 2 open pages can be copied into a 1-side paper.

- Series: Originals with 2 open pages will be copied by series according to the page numbers.

- Binding position: When you have selected Series, select the open direction of the original to scan as binding

position. Two-open page originals with left binding, select the left binding, and for two-open pages with right binding, 
select the right binding. If incorrect binding position is selected, the order of two open pages will be switched.
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-  Erase border: Four sides in the frame of the original will be erased with a same margin. 

 Shadows in center will be erased if the flatbed cover is not closed completely due to the thickness of originals.
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1. Basic Fax Functions
 1  Select [Fax] on the LCD home screen to enter the fax setting mode.

 2  Place a document on flatbed glass or automatic reverse document feeder (ARDF).

   - When sending a fax from flatbed glass, make sure there is no document on ARDF.

 3  Select fax options needed.

   - Basic fax options

   - Advanced fax options

 4  Select a button as in the figure below and enter the receiver’s fax number.

   ① Use number key pad to enter the number (direct dialing)

      Use number keys to enter a fax number of recipient and select [  ]. 

    -  You can enter up to 40 digits.
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   ② Use address book
      [  ]: select this button.

    Select a user to send fax and choose [Close].

  - For details on how to add or delete from address book, see P. 8-5 「3. Address book」.
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   ③ Use Speed dial
      - To use a registered speed dial
        [  ]: select this button.
     Select a speed dial previously registered and choose [Close].

▼

      -  To enter a fax number directly
        Press # on the number key pad and enter a 3-digit number. 
     Ex) #001: speed dial #1
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2. Fax setting
2.1 Resolution
 1  On the LCD home screen, select [Fax] - [Resolution] to choose a resolution for original.

 2  Select an option from [Standard], [Fine], [Super fine], and [Ultra fine] for the resolution

Standard (basic default) for originals with regular size texts

Fine  for originals such as newspaper with small texts

Super fine for originals such as dictionary with fine texts or photos

Ultra fine (400dpi) Ultrafine (400dpi)
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2.2 Original type
 1  LCD On the LCD home screen, select [ ]→ [Fax]→[Original type] to choose an original type.

 2  Select [Text] or [Photo] for the type of original to use.

Photo - for originals including photo and images with contrast
- It takes a longer time to send images with contrast.

Text → Basic document type - for originals with standard texts
- It takes a shorter time to send images in black and white.
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2.3 Original size
 1  On the LCD home screen, select [ ]→[Fax]→[From] to choose a size of original.

 2  Select a size of original to send.

 3  After finishing selection, select [Close].
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2.4 Density
 1  On the LCD home screen, select [ ]→[Fax]→[Density] to choose a density of original.

 2  Select a density to use.

 3  When [Auto] is selected, the density of image is adjusted automatically after original is scanned. 
   Heavy textures of the originals (newspaper or recycled paper) are printed without the background.
   If original paper have shades or black image on the front end of the manuscript it can be brighter.
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2.5 Redial
 This option is used to send a document again. The last transmitted fax number is displayed in the recipient area.

 1  Select [Fax] on the LCD home screen to enter the fax mode.

 2  Place a document on flatbed glass or automatic reverse document feeder (ARDF).

   - When sending a fax from flatbed glass, make sure there is no document on ARDF.

 3  [  ]: select this button to view the last transmitted fax number in the recipient area.
    If there are multiple recipients for the last transmitted fax, the phone number from the last transmission is 
   displayed in the recipient area.

▼
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 4  Select a number displayed and press the 【 】 button.

 5  Scan the original to start sending fax.

   - To cancel fax transmission, select [Job manager]-[Fax] on the LCD home screen and choose [Cancel].

   - To confirm the fax cancellation, a message, [Cancel the job? (Yes, No)], appears on the screen.
    When [Yes] is selected, the transmission becomes cancelled.

2.6 Add fax number
 This function allows user to send a same document to multiple destinations one by one. 
 Up to 200 destinations can be selected.

 1  Select [Fax] on the LCD home screen to enter the fax mode.

 2  Place a document on flatbed glass or automatic reverse document feeder (ARDF).
   - When sending a fax from flatbed glass, make sure there is no document on ARDF.

 3  Select fax options needed.

   - See P. 5-2 「1. Basic fax functions」 for details.

 4  Enter a fax number of destination.

   ①  Use number key pad to enter the number (direct dialing)
    - You can enter up to 40 digits.

   ②  Use speed dial

         - To use speed dial button

                [  ]: select this button.

                Select a number from address book to send fax and choose [Close].

         - To enter a number directly
                Press [  ] and enter a 3-digit number. 
                                   Ex) #001: speed dial #1
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3. Fax Tx/Rx
3.1 Onhook Tx

 1  Press [On-hook] button to set it On.
    A beep sound from speaker confirms the status.

 2  Place a document on flatbed glass or automatic reverse document feeder (ARDF).
   When sending a fax from flatbed glass, make sure there is no document on ARDF.

 3  Use number key pad to enter a fax number of recipient.

 4  Make sure you hear a call waiting tone from the fax machine of your destination.
   If a wrong number is entered or there is no response, press the [On-hook] button to enter the Wait mode.

 5  When you hear the connection tone (bee--) after your call is successfully connected to the destination fax, press  
   the【  】button to send the document.

 6  When transmission is complete, the device becomes Off-hook automatically and returns to Wait mode. 
   When you send a fax manually, you cannot use Broadcast Tx function.

  - When you send a fax with On-hook from the flatbed glass, you can scan the next original within 10 seconds to  
   send the fax.

3.2 Direct Tx
 The direct Tx function tries to communicate with a recipient first.
 When there is a response from the recipient, the device starts scanning and sends the scanned document.

 1  Select [Fax] on the LCD home screen to enter the fax mode.

 2  Place a document on flatbed glass or automatic reverse document feeder (ARDF).
   When sending a fax from flatbed glass, make sure there is no document on ARDF.

  - To set resolution and density, go to the Fax mode to configure.
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 3  Select [Direct Tx].

 4  Select the 【 】button.
    - The device starts dialing. When connected to a recipient, the device starts scanning and sends the scanned  
    document.

  - When you send a fax with Direct Tx from the flatbed glass, you can scan the next original within 10 seconds to  
   send the fax.

  - While in communication, the Direct Tx cannot be used. When user tries the Direct Tx while in communication, 
   it switches to standard memory Tx.

3.3 Quick Tx
 When this function is used, the device starts communication when the first document is scanned and saved in the  
 memory.

 1  Select [Fax] on the LCD home screen to enter the fax mode.

 2  Place a document on flatbed glass or automatic reverse document feeder (ARDF).
   When sending a fax from flatbed glass, make sure there is no document on ARDF.

  - To set resolution and density, go to the Fax mode to configure.
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 3  Select [Quick Tx].

 4  Select the 【 】button.
    - The device starts scanning. When the first document is ready, the device starts communication.

  - When you send a fax with Direct Tx from the flatbed glass, you can scan the next original within 10 seconds to  
   send the fax.

  - While in communication, the Quick Tx cannot be used. When user tries the Quick Tx while in communication, 
   it switches to standard memory Tx.

3.4 Delay transmission (Delay Tx)
 You can send a document at a designated time without sending it immediately. 
 When you set a time, the document is saved in the memory and on stand-by until the set time. 
 When the set time comes, the device sends the document automatically.

 1  Select [Fax] on the LCD home screen to enter the fax mode.

 2  Place a document on flatbed glass or automatic reverse document feeder (ARDF).
    When sending a fax from flatbed glass, make sure there is no document on ARDF.

  - To set resolution and density, go to the Fax mode to configure.
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 3  To set resolution and density, go to the Fax mode to configure.

   

 4  Select “On” for [Reserved Delay Tx]

 5  When you select “On” for [Reserved Delay Tx], you can select the time. Use number keys to enter a time.

   When you select “On” for [Delay send], you can select the time. Use number keys to enter a time.

 6  Select the 【 】button.
           The device scans the original and saves it in the memory to finish working.
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3.5 Polling Tx
 When polling tx is requested by your recipient, saved document is sent to the memory for polling. 
 When this function is used, the receiver will be charged for the communication fee.

 1  Select [Fax] on the LCD home screen to enter the fax mode.

 2  Place a document on flatbed glass or automatic reverse document feeder (ARDF).
    When sending a fax from flatbed glass, make sure there is no document on ARDF.

  - To set resolution and density, go to the Fax mode to configure.

 3  Select [Polling] in Extended.

 4  Select [On] for Polling Tx.

 5  Select the 【 】 button.
           The device scans the original and saves it in the memory to finish working.
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3.6 Polling Rx
 This function is to request to receive polling documents from your opposite side. 
 For polling Rx, the recipient is responsible for the communication fee.

 1  Select [Fax] on the LCD home screen to enter the fax mode.

 2  Select [On] for Polling Rx.

 3  Use number keys, speed dial, or address book to enter a number of sender.

 4  Select the【 】button.
           Receive an original from the entered receiver and print it to finish working.

3.7 Manual Tx
 This option can be used when connecting to external phone. 
 External phone is used to make a call and to transmit a fax.

 1  When you lift the receiver of external phone, the device will show a pop-up window, “Enter a fax number and  
   select Start button”.

 2  Use external phone to make a call to receiver and select [Fax] on the LCD home screen to enter the fax mode.

 3  Place a document on flatbed glass or automatic reverse document feeder (ARDF).
    When sending a fax from flatbed glass, make sure there is no document on ARDF.

 4  Select the 【 】 button.
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       The device switches to Fax Rx. When the tone from external phone becomes silent, the switch is complete and  
   you can hang up the phone.

3.8  Manual Rx
 This option allows user to select RX manually instead of automatic Fax Rx when there is an incoming fax. There are  
 two options for manual Rx: Rx with device, and Rx with external phone.

 ①   Manual Rx with device
    - When an incoming fax is detected, a pop-up window saying “Fax Rx has been detected.” opens. 
    You can select “Yes” or “No” and receiving fax starts when you select “Yes”. 
    Receiving fax will be declined when you select “No”.

  - “On” must be selected for [Setting] → [Fax setting] → [Manual Rx] for device to receive fax manually.
 

 ②  Manual Rx with external phone
   - When receiving a fax with external phone, you can enter a Rx switch code to receive the fax. 
    Enter “* + (Rx switch code) + *” with number keys on external phone to switch to Fax Rx. 
    The phone becomes silent when the switch is complete.

  - When there is an incoming call detected, the Rx switch code is displayed in the pop-up window.
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4. Send fax from computer
 When you install the computer fax driver, you can send fax from your computer by using the fax driver.

 1  Open a document to fax from the application program.

 2  Select [Print] from the [File] menu.

 3  Check if the computer fax driver is selected.

 4  Open the [Properties] screen to change settings and select [OK].

 5  Click [OK] in the [Print] window, then [Fax Wizard] window will open.

 6  Select settings in the [Cover page], [Recipient], and [Fax setting] tab in the [Fax Wizard] window. 
   Refer to the table for more information.

 7  Press [Send] button in the [Fax Wizard] window to send the fax.
   Fax data is transferred from computer to MFP, and actual fax operation is performed by the MFP.
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Setting tab Menu Description

Cover page Cover page Select to use the cover page option

Receiver Enter a receiver of fax.

Sender Enter a sender of fax.

Title Enter a title of fax.

Date The date to send fax is automatically included.

Time The time to send fax is automatically included.

Receiver Name, fax number Enter name and fax number of receiver manually.

Phone book Select a receiver from the phone book.

Fax setting Quality Select Standard, Small, or Fine.

Image type Select either Text or Photo.

Delay Tx Set a time to send a delayed fax.

Fax code Select either ECM or T.34.

Basic setting Select it to reset settings and restore default settings.

Preview - Select it to preview the fax data to send.

Send - Select it to start sending fax.

Cancel - Select it to cancel sending fax.
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1. Simple Mode
Default settings in the Simple Mode are configured for you to easily access and use the copy, scan, and fax function

1.1 Simple copy

Default screen

①

⑥⑤④③②

⑧

⑦

① Duplex 
  - For details on how to configure, see P. 2-10. Duplex setting.

② Original : Select type of originals for flatbed or ARDF(automatic reverse document feeder).
  - For details on how to configure, see P. 2-4. Original setting.

③ Paper : Select a paper tray to print from. You can choose paper size and type.
  - For details on how to configure, see P. 2-5. Paper setting.

④	 Original type : Select a type of original.
  - Text : For scanning document with text only.
  - Text/photo : For scanning document with photos, images, and text.
  - Photo : For scanning document with photos and images.
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⑤	 Density
  Select the a desired density.

  - It gets lighter as moving to the left and darker as moving to the right. Default density setting is 5
  -  Auto : The copier scans density of the original and automatically adjusts the density of images.
                       Heavy textures of the originals (newspaper or recycled paper) are copied without copying the
                       background.
          If original paper have shades or black image on the front end of the manuscript it can be brighter.

⑥	 Ratio : Selects position and size of the papers to print.
  - For details on how to configure, see P. 2-13. Scale setting.

⑦	 Collate : Make sets of copies in the page order.   

⑧	 Additional setting : Return to regular copy setting screen. More detailed copy settings are available.
  - For details on how to configure, see P. 2-3. Copy setting
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1.2 Simple scan
Default screen

①

③ ④ ⑤ ⑥ ⑦

② ⑧

①	 Scan to send 
  User can scan an original and send the image of it. Available options include “Send by mail”, “Send to shared  
  folder”, and “Send via FTP”.
  - For details on how to configure, see P. 4-13. Scan to send.

②	 Scan to save 
   User can scan an original and save the image of it. It can be saved in a hard drive or USB.
  - For details on how to configure, see P. 4-20. Scan to save.

③	 Resolution
  From the LCD screen, select a resolution option for the document to scan. User can select a value between 
  150 dpi and 600 dpi for the resolution.

④	 Originals
  From the LCD screen, select a size of the document to scan.
  If an original is in standard size, the size will be detected automatically.
  - For details on how to configure, see P. 4-9. Original setting.

⑤ Save as
  User can select a file type to save.
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⑥	 Original type
  You can select a type of original to scan.

  [Color] : For scanning color-printed paper in color.
  [Gray scale] : For scanning color-printed paper in gray scale.
  [B&W text] : For scanning black & white printed paper in black & white.
  [B&W image] : For scanning black & white printed paper with photos in black & white.

⑦	 Duplex
  User can scan a 2-side original.
  To scan a 2-side original, select [Duplex] and choose either [Top to Top] or [Top to bottom].

⑧	 Additional setting 
  Return to regular scan setting screen. More detailed scan settings are available.
  - For details on how to configure, see P. 4-19. Scan setting
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1.3 Simple fax
Default screen

①

④ ⑤ ⑥ ⑦ ⑧

② ③ ⑨

①	 On-hook
  User can use the On-hook function to send a fax manually.
  - For details on how to configure, see P. 5-11. On-hook setting.

②	 Tx setting
  User can use the keypad for manual input, speed-dial, and address book.
  - For details on how to configure, see P. 5-2. Basic fax function.

③	 Redial
  The last transmitted fax number is displayed in the recipient area.
  If there are multiple recipients for the last transmitted fax, the phone number from the last transmission is
  displayed in the recipient area.

④	 Original size
  User can select a size of original.
  - For details on how to configure, see P. 5-7. Original size.

⑤	 Resolution
  Select an option from [Standard], [Fine], [Super fine], and [Ultra fine] for the resolution.
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Standard (default resolution) For originals with regular size text

Fine For originals such as newspaper with fine text

Superfine For originals such as dictionary with superfine texts or photos

Ultra fine (400dpi) For originals with ultra fine text or photos

⑥	 Originals
  User can select a type of original.

Photo
- For originals including photos and images with contrast
- Sends contrast information and takes longer time

Text → Basic document type - For originals with regular texts
- Sends black & white information and takes shorter time
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⑦	 Density
  Select a density to use.

  When [Auto] is selected, the density of image is adjusted automatically after original is scanned. 
  Detects darker background (newspaper or recycled paper) of the originals and prevents it from appearing in the  
  scan result.
  If original paper have shades or black image on the front end of the manuscript it can be brighter.

⑧	 Duplex 
  User can send a duplex-printed original by fax.

⑨	 Additional setting
  Return to regular fax setting screen. More detailed fax settings are available.
  - For details on how to configure, see P. 5-2.  Basic fax function.
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1. General Settings
 User can select options including basic setting, network, paper/tray, language, and report.

1.1 Basic setting
 Basic setting table

Basic

1. Panel Key Sound

2. Power Save (1-240) Min

3. Auto Power OFF

4. Auto initialize Time

5. Auto reset screen 

6. Time/Time set

7. Wait[Busy]

8. Wait[Idle]

9. Slide Effect

10. Remove Dust

11. Sensor Border Correction

12. Unit 

13. Factory default

14. FirmWare Update

  Configure basic settings
 1  Select [Setting] on the LCD home screen to enter the setting mode



7-3

General Settings 7

 2  Select [General].

 3  Select [Basic].

 4  Select an option and press a desired button to configure.

Menu Item Description Value

Panel Key Sound Alarm
On/off setting

*ON/OFF 
Quieter/*Normal/Louder

Power Save Set the time to go into the power save mode (in min.)
*Intelligent: Memorize and analyze the printer usage 
pattern and automatically adjust the time to start the 
power save mode.

1~240
OFF (do not use power save mode)
*Intelligent(Intelligent power sav mode)
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Menu Item Description Value

Auto power off Set the power to turn off automatically at a specified 
time.

ON/*OFF 
AM/PM/HH/MM

Auto initialize Time Set time to reset the user settings
Time in second(s)

10~600 
*60

Auto reset screen Set the screen to return to when it reaches the auto 
reset time configured.

*Home, copy, scan, fax

Time set Set the system time and time zone of the country. -
Time zone for each country

Wait[Busy] Set time to enter the intelligent power save mode 
while the device is working (minutes)

1~60
*60

Wait[Idle] Set time to enter the intelligent power save mode 
while the device is idling (minutes)

1~60
*1

Slide Effect Set the speed to slide screen *ON/OFF
Slow/Normal/*Fast

Remove Dust Remove vertical black line due to dust on flatbed 
glass when copying or scanning documents with 
ARDF.

  -  The lines removed by this option may make 
     document look unnatural.

*ON/OFF
*Activate Popup/Deactivate Popup

Sensor Border 
Correction

Calibrate the images near the scanner sensor border. ON/*OFF 

Unit Set unit for length. *mm/inch
◈Factory default Restore the factory default settings Recovery
▣Firmware Update Update firmware via network Update

 * is the factory default setting.

 ◈ Factory default setting

  User can restore factory default settings by selecting Factory Default Setting in General Setting menu when  
  necessary.
  To restore the factory default settings, follow the procedure below.

 1  Select [Setting] on the LCD home screen to enter the setting mode.
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 2  Select [General].

 3  Select [Basic].

 4  Scroll down to [Factory default] and select [Recovery].
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 5  The LCD screen will show [Do you want to initialize setting/save?] 
   The screen will show [Cancel] and [Restore].

 6  When you select [Restore], the device will restart.
   Note that all settings will be reset to factory default settings.

 ▣ Firmware update

 1  Select [Setting] on the LCD home screen to enter the setting mode.
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 2  Select [General] to enter the general setting menu.

 3  In [Basic], scroll down to [Firmware Update] and select [Update] button.

 4  The LCD screen will show [Will you update the firmware?] message.

 5  Select [Confirm] to update the firmware. 
   Select [Cancel] if you do not wish to update the firmware.
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1.2 Network setting
  Network settings table

Network Wired Network IP setting DHCP

Static IP address

IPv6

Net mask

Gateway

DNS Server1

DNS server2

Mac address

Wifi Network Wifi On/Off

SSID Show Connected wifi

Connect setting

IP setting DHCP

Static IP address

IPv6

Net mask

Gateway

DNS server 1

DNS server 2

Mac address

Saved SSID clear

WiFi direct Wifi Direct

IP show

SSID Setting

Encryption mode

Password

Connection list

General setting 1. E-mail Transfer User name

E-mail address

SMTP server

SMTP ID

SMTP password

SMTP security

SMTP port
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2. Status e-mail alert Mail alert

Alert option No toner

Replace drum

Need of repair

No paper

Paper jam

Tray full

Admin e-mail address E-mail address 1

E-mail address 2

E-mail address 3

E-mail address 4

E-mail address 5

E-mail address 6

E-mail address 7

E-mail address 8

E-mail address 9

E-mail address 10

 
  - Numbers inappropriate for the IP address format cannot be entered.

 - Using both network cable and Wifi module together is not recommended for electronic devices which can be  
  connected to a network. Due to characteristics of network communication, data may not be processed properly  
  when data is coming in via both wired and wireless network.
  Using both wired and wireless network is not recommended for this device.

 - A 12-digit number must be entered as an IP address and each group must be in 3 digits; enter “0” to complete a  
  3-digit number if there is only 1 or 2-digit number.

 - An IP address is in 12 digits; 4 groups, 3 digits in each group. When there are only 2 digits in a group, enter “#” to  
  fill the first digit with “0”. Then the next group will be ready to enter a number.
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 Network setting

  Wired setting
 1  Select [Setting] on the LCD home screen to enter the setting mode.

 2  Select [General] to enter the general setting menu.

 3  Click [Network].
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 4  Select [Wired network].

Menu Item Menu Item Description Value

Wired network IP setting Select to use automatic or
fixed IP address.

Auto setting
Manual setting

IP setting DHCP Allocate IP address automatically

Static Enter IP address directly.
 IP address, netmask,

Gateway address, DNS server 1,
And DNS server 2 must be all
entered. Contact your network
admin for details.
IPv6: Show the IP address of IPv6
for the current printer.
MAC address: Show the Mac
address which is an identifier of 
network device.

IP address:
     000.000.000.000 ~
     255.255.255.255
Netmask:
     000.000.000.000 ~
     255.255.255.255
Gateway:
     000.000.000.000 ~
     255.255.255.255
DNS server 1 :
     000.000.000.000 ~
     255.255.255.255
DNS server 2 :
     000.000.000.000 ~
     255.255.255.255

IPv6 Show the IP address of IPv6 for
the current printer.

0000:0000:0000:0000:
0000:0000 ~
FFFF:FFFF:FFFF:FFFF:

Mac address Show the Mac address which is an 
identifier of network device.

00: 00: 00: 00: 00: 00 ~
FF:FF:FF:FF:FF:FF
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 5  After finishing wired setting, select the [Save] button. 
   To cancel selections, press [Cancel].

  Wifi setting: Wifi kit (optional)

 1  Select [Network] to enter the network setting mode.

 2  Click [Wifi network].
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Menu Item Menu Item Description Value

Wifi network Wifi On/Off Select whether to use Wifi  On, *Off
Off is the default setting. 
When you select On, choose 
SSID to connect to network.

SSID 
Show

Connected 
Wifi

View the wireless AP device 
currently connected.

Name of connected Wifi

Connect 
setting

Show the wireless AP devices 
to connect.

Connection setting

IP setting DHCP Use automatic allocation of IP 
address

Static Enter IP address directly.
 IP address, netmask, 

gateway address, DNS server 
1 address and DNS server 2 
address must be all entered. 
Contact your network admin for 
details.
IPv6: Show the IP address of 
IPv6 for the current printer. MAC 
address: Show the Mac address 
which is an identifier of network 
devices.

IP address:
     000.000.000.000 ~
     255.255.255.255
Netmask:
     000.000.000.000 ~
     255.255.255.255
Gateway: 
     000.000.000.000 ~
     255.255.255.255
DNS server 1: 
     000.000.000.000 ~
     255.255.255.255
DNS server 2: 
     000.000.000.000 ~
     255.255.255.255

IPv6 Show the IP address of IPv6 for 
the current printer.

0000:0000:0000:0000:
0000:0000 ~
FFFF:FFFF:FFFF:FFFF:
FFFF:FFFF

Mac address Show the Mac address which is 
an identifier of network devices.

00: 00: 00: 00: 00: 00 ~
FF:FF:FF:FF:FF:FF

Saved SSID clear Disconnect wireless AP devic-
es currently connected.* This 
option cannot be selected until 
user tries to connect the device 
again after it is disconnected.

clear

 * is the factory default setting.
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 3  After finishing Wifi setting, select the [Save] button. To cancel selections, press [Cancel].

  Wi-Fi direct setting: Wifi kit (optional)

 1  Select [Network] to enter the network setting mode.

 2  Click [Wi-Fi direct].
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Menu Item Menu Item Description Value

WiFi direct Wifi direct Select to use WiFi direct. On/*Off
Off is the default value. 
When On is selected, sub 
items must be selected.

IP show Show IP for the device which servers as 
wireless AP.

IP of connected Wifi 

SSID Setting Set name of AP to search from other devices.

Encryption mode Set an encryption method to apply when 
accessing to the device from other devices.

None  
WEP 
WPA 
WPA2
WPA/WPA2

Password Set a password to apply when accessing the 
device from other devices

Connection list Show Mac address of connected devices. Show

 * is the factory default setting.

 3  After finishing Wi-Fi direct setting, select the [Save] button. 
   To cancel selections, press [Cancel].

  General settings
 1  Select [Network] to enter the network setting mode.
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 2  Select [General].

Menu Item Menu Item Description Value

E-mail Transfer User name  Set user name to send email.

Email address Set email address to send email. Example) email@domain,com

SMTP Server Set SMTP server address to 
send Email.

For details on SMTP server address,
contact email server admin or
service provider.

SMTP ID Set ID and password to log into 
the email server.

ID and password of SMTP server ac-
count (ID)SMTP password

SMTP Security Select the security options 
for the SMTP server to send 
email

*None, SSL, TLS, STARTTLS
None is the default value.
For details on security options, Contact 
email server admin or service provider.

SMTP port Set port number to connect to 
email server.

Contact email server admin or
service provider for port number.

Status e-mail 
alert

Mail alert Set whether to send an email 
notice of device status to Admin

ON/*OFF
OFF is the default value.

Alert option Set in which condition to send an
email notice to admin

*No toner 
*Replace drum
*Need of repair
No paper
Paper jam
Tray full
No toner/ Drum cartridge
/ Machine repair need is the defaults.

 * is the factory default setting.
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Menu Menu Description Value

Admin e-mail
address

Set admin email address to send
an email notice of the current status

E-mail address 1
E-mail address 2
E-mail address 3
E-mail address 4
E-mail address 5
E-mail address 6
E-mail address 7
E-mail address 8
E-mail address 9
E-mail address 10
Blank is the default value.

 3  After finishing general setting, select [Save]. 
   To cancel selections, press [Cancel].

1.3 Paper / Tray 
 Paper / Tray setting table

Paper / Tray General 1-Tray Priority Tray Tray 1

Tray 2

Tray 3

Tray 4

MPT

2- Substitute A4/Letter

3- Limitless on using MPT

4- Auto popup for MPT

5- Output tray Copy

Fax

USB Print

MPT paper size 1-MPT paper size MPT

Paper type 1-Paper type Tray 1

Tray 2
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Tray 3

Tray 4

MPT

 Paper/Tray setting

  General setting

 1  Select [Setting] on the LCD home screen to enter the setting mode.

 2  Select [General] to enter the general setting menu.

 3  Click [Paper / Tray].
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 4  Select [General].

Menu Item Description Value

Tray Priority Select basic tray to use. * Set the default tray to feed papers from Tray 1, Tray 2, 
Tray 3, Tray 4, or MPT.
Tray 3 and 4 are displayed after they are intalled and 
trays with same paper size and type are connected 
automatically. To disable auto tray connection, change 
the tray settings to make settings of trays do not match.

Substitute A4/
Letter

A4 paper and Letter paper can be 
used interchangeably

*On
Off

⊙ Limitless on     
   using MPT

Select to use the limitris MPT
function when there is no paper.

*On
Off

Auto popup for 
MPT

Select to display pop-up window
when paper is inserted to the MPT

*On
Off

Output tray Each mode(Copy,Fax,USB Print) you 
can choose Output tray

Copy,USB Print mode : *Standard Output tray
Fax mode : *Upper Output tray
※Upper Output tray’s capacity is 100 sheets
    Duplex job’s sheets are Out to Standard output tray

* is the factory default setting.

⊙ The limitless function enables to continue printing from another paper tray with the same size papers when the 
current paper tray runs out of papers while printing.

 5  After finishing general setting, select [Save]. To cancel selections, press [Cancel].
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  MPT paper size

 1  Select [Setting] → [General] → [Paper / Tray] → [MPT paper size].

 2  Select a paper size to feed in the MPT. After finishing paper setting for MPT, select the [Save] button. 
   To cancel selections, press [Cancel].

  Paper type

 1  Select [Setting] → [General] → [Paper / Tray] → [Paper type].
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 2  Select a paper type to feed in the tray. 
   After selecting the paper type for tray, select [Save]. 
     To cancel selections, press [Cancel].
  

  Language setting
 Select a language to use.

 1  On the LCD home screen, select [Setting]→ [General] → [Language].

▼

   

▼
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 2  Select a language to use and press [Save].

1.4 Report
 The system report is used to print a page which shows the initial device settings and make sure that device options  
 are appropriate.

 1  Select [Setting] on the LCD home screen to enter the setting mode.
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 2  Select [General] to enter the general setting menu.

 3  Select [Report].

Menu Item Description Value

System The system report is used to print a page which shows the initial 
device settings and to make sure that device options are installed 
properly.

Network Show the network settings and information. User can check the 
network settings with this report.

Error Show the history of device errors.
Up to 30 most recent errors can be printed.

Log Print the completed fax job history.

Tx result Report Print the fax Tx results.

Rx result Report Print the fax Rx results.

Fax List Print the fax document list stand-by in the memory.

Fax Spam list Print the list of saved SPAM numbers.

Font list Print the list of PCL/PS fonts embedded in the device. PCL
PS
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 4  Select a report to print out.



7-25

General Settings 7

2. Copy setting
2.1 Copy setting table

Copy setting 1- No. of copies

2- Original size

3- Tray

4- Ratio

5- Original type

6- Copy quality

7- Print density

8- Copy density

9- Auto density Intensity

10- Collate sort

11- Duplex copy

12- General Scan Wait 
Time

2.2 Copy setting

 1  On the LCD home screen, select [Setting]→ [Copy setting].

▼
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Menu Item Description Value

No. of copies Set a number of copies to make 1~999, *1

Original size Set a size of original to copy *Auto, A4LEF, A4SEF, A3, A5 SEF, A5 LEF, B5 
SEF, Letter, Legal, Statement, etc.

Tray Set a paper tray to use for copying *Auto tray, Tray 1, Tray 2, Tray 3, Tray 4, MPT

   - Tray 3 and 4 are displayed only when they are 
       installed.

Ratio Set a scale for copies Auto, *100%, Preset scale, 
Custom scale (25%~400%)

Original type Set a type of original to copy Text, *Text/Photo, Photo

Copy quality Select quality of copies to make *Normal, High 

Print density Select a print density of copies 1~9, *5

Copy density Select a scan density for copying 1~9, *5

Auto density Select whether to adjust the 
density of copies automatically.

*On, Off

Intensity Select a level of auto density 
function.

1~9, *5

   - Activated only when the auto density is On.
   - Shades or black images are on the original,     
      the overall brightness may get brighter. 
      Select a lower number for density to adjust   
      the brightness to match the original’s 
      brightness.

Collate sort Select whether to make copies by 
series

*On, Off

Duplex copy Set duplex settings for originals 
and copies.

*1side→1side, 1side→2side,
 2side→1side, 2side→2side 

General Scan Wait Time Stand-by time for the next scan 
(seconds)

0~120, *30 

 * is the factory default setting.

 
  - Auto tray setting and auto ratio cannot be selected together.

 2  After finishing copy setting, select the [Save] button. 
   To cancel selections, press [Cancel].
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3. Scan setting
3.1 Scan setting table

Scan setting 1- Save in

2- Original Size

3-Color/BW

4-File type

5-Scan density

6-Resolution

7-JPEG Quality

8-Duplex

9-General scan Wait time

3.2 Scan setting

 1  On the LCD home screen, select [Setting]→ [Scan setting].

▼
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Menu Item Description Value

Save in Select where to save a scanned file *USB, E-mail, FTP, SMB, WebDAV

Original Size Select a size of original to scan *Auto, A4LEF, A4SEF, A3, A5 SEF, A5 LEF,
B5 SEF, Letter, Legal, Statement, etc.

Color/BW Select a color type of image to scan Color, *Gray scale,Black&White(Text), 
Black&White(Photo) (B/W mode is not sup-
ported when JPEG file format is set)

File type Select a file format to save scanned 
image

TIFF, *PDF, JPEG, Secure PDF
*multi page, single page

Scan density Select density of image to scan 1 ~ 9, *5

Resolution Select resolution of image to scan 150X150dpi, 200X200dpi, *300x300dpi, 
600x600dpi

JPEG quality Select quality of JPEG files to save Low, *Normal, High

Duplex Select 1side or 2side for the original to scan *1side, T to T 2sides, T to B 2sides

General scan Wait 
time

Set the waiting time for the next original 
scan when using flatbed glass (second)

0~120, *30

 * is the factory default setting.

 2  After finishing scan setting, select the [Save] button. 
   To cancel selections, press [Cancel].
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4. Fax setting: Fax kit (optional)
4.1 General Setting

  General setting table

General 1-Station ID

2-Station No.

3-ECM

4-Line monitor

5-Volume

6-Tx success alarm

7-Rx success alarm

 General setting

 1  On the LCD home screen, select [Setting]→ [Fax setting] → [General].

▼

   

▼
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Menu Item Description Value

Station ID Enter station ID or names to use. Up to 40 characters including 
numbers can be entered as ID.

Use LCD 
keyboard.

Station No. Enter station phone number to use.
Up to 40 numbers can be entered as station number.

Use LCD
 keyboard.

ECM Errors during Tx/Rx can be corrected to make communication
successful. Device of your destination must support ECM to
make this function available.

On
*Off

Line Monitor User can monitor the communication line while document is
transmitted. The line tone from speaker will sound when this option 
is on.

Off
*On Till Connect
Always on

Volume User can set the speaker volume. 0~7
*3

Tx success alarm User can set an alarm to sound when Tx is successful. On
*Off

Rx success alarm User can set an alarm to sound when Rx is successful. On
*Off

 *is the factory default setting

 2  After finishing general setting, select the [Save] button. To cancel selections, press [Cancel].
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4.2 Send Setting

  Send Setting table

Send 1-Original size

2-Resolution

3-Type

4-Fax density

5-Auto density / Intensity

6-Dial Prefix

7-Number of Redial

8-Interval for Redial

9-TTI

10-Wait time to next doc.

11-Duplex scan

 Send Setting

 1  On the LCD home screen, select [Setting]→ [Fax setting] → [Send].

▼

   

▼
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Menu Item Description Value

Original size Select a size of original to use. *Auto, A4LEF, 
A4SEF, A3, A5 SEF, 
A5 LEF,B5 SEF,
Letter, Legal, 
Statement, etc.

Resolution Select a resolution to use.
Standard: For originals containing standard fonts
Fine: For originals such as newspaper containing fine fonts.
Superfine: For originals such as dictionary containing superfine      
                 fonts or images
Ultrafine: For originals such as dictionary containing ultrafine
                fonts or images

*Standard
Fine
Super fine
Ultra fine

Original type Select a type of original to use.
Text: Regular texts in black and white
        It takes a shorter time to send simple black and white texts.
Photo: Documents containing photos or images with contrast.
        It takes a longer time to send due to photos with contrast.

*Text
Photo

Fax density Select a density of image to send. 1~9
*5

Auto density Select a function to automatically adjust the background of 
scanned Images.
Intensity: User can choose how much of brightness
               will be compensated in the background.

*On
Off

Dial Prefix Select to add an area code automatically when making a call. Always On
*Off
Use LCD keyboard.

Number of Redial Set a number of times to redial again when transmission
is not successful because the fax line is busy or any error
has occurred.

0~5
*2

Interval for Redial Set a time interval between calls when redialing. 1~5(minute)
*2
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Menu Item Description Value

TTI Set whether to include information of sender (name & fax num-
ber)
in the transmitted document.
The following user information is included:
[Date: YYYY-MM-DD] [Time: HH : mm] [Station ID]
[Station number] [Page : N(current) of M(total)]
Hours is in 24-hour format and for Onhook/Direct/Quick Tx,
page is displayed as [Page : N(current)].

*On
Off

Wait time to next doc. When scanning from the flatbed scanner glass, the scan job
comes to an end if there is no further action within the time set 
(seconds).

1~120
*30

Duplex scan When scanning with automatic reverse document feeder (ARDF),
both sides of the original are scanned when Duplex is On.

On
*Off

 * is the factory default setting

 2  After finishing Send setting, select the [Save] button. 
   To cancel selections, press [Cancel].
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4.3 Receive Setting   

  Receive Setting table

Receiver 1-Recipient(s) Info

2-Manual Rx

3-Rx Switching Code

4-Fax forwarding setting Forward number

5-Number of Ring

6-Auto reduction Reduction length

7-Print mode

8-Tray

9-Duplex Print

10-Spam Spam list

11-File Save

12-Save Type

13-Destination

14-E-mail setting SMTP sever

SMTP E-mail Addr.

SMTP password

SMTP port

Sender

Receiver E-mail address

E-mail title

E-mail message

15-FTP Server Name

Path

ID

Password

Port

16-SMB Server name

Path

ID

Password

Port
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17-WebDAV Server name

Path

ID

Password

Port

 Receive Setting

 1  On the LCD home screen, select [Setting]→ [Fax setting] → [Receive].

▼

▼
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Menu Item Description Value

Recipient(s) Info Select whether to add sender's information (name and fax number)
on the bottom of the document.

On
*Off

Manual Rx Select whether to use manual Rx mode instead of using automatic
Rx mode.

*On
Off

Rx Switching 
Code

Set Rx forward code to switch to external line to receive
document manually.
default: *9*

0~9
*9

Fax forwarding 
setting

Set to re-transmit a received fax to specified numbers
automatically with certain options.
Can be used to automatically resend a fax received in your office
to your residence in holidays.
Forward Number: Save a number to forward fax.
                             When specified, it will not be deleted until
                             it is changed to a new number.

On
*Off
LCD 입력기로 입력

Number of Ring Select a number of rings to sound when sending a tone
to transfer fax.

1~7
*3

Auto Reduction If the received document is bigger than the paper to print,
It is automatically reducted to print.
Discard Length: a number between 1~30 can be selected.

*On
Off
Use LCD keyboard.

Print mode Select how to print received documents.
Quick print: print a document page by page as it is received.
Print after reception: receive all documents and print them together.

Quick print
*Total print

Tray Select a tray for fax transmission.
Choose a tray from the options.
Tray 3 and 4 are displayed only when they are installed.

*Auto
Tray 1
Tray 2
Tray 3
Tray 4
MPT

Duplex Print Set to print both sides of the document received. Duplex
*1-side

Spam Set SPAM numbers you do not wish to receive.
Block faxes originated from the SPAM numbers.

On
*Off
Spam list

File Save Save a received document instead of printing it. On
*Off

Save Type Select in which file format received document is saved. *PDF, TIFF
*Multi page,
 single page

Destinationn Select where to send the saved document by using a network. *Email
FTP
SMB
WebDAV

E-mail setting Enter email information to forward received document. Received doc-
ument is forwarded to a specified email address.
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Menu Item Description Value

FTP Enter FTP information to receive document.
Received document is forwarded to the path of specified FTP server

SMB Enter SMB information to receive document. Received document is 
forwarded to the specified SMB.

WebDAV Enter WebDAV information to receive document.
Received document is forwarded to the path of specified WebDAV 
server.

 * is the factory default setting.

 2  After finishing Receive Setting, select the [Save] button. 
   To cancel selections, press [Cancel].
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4.4 Security Function   

  Security Function table

Security 1-Password

2-Confidential Tx

3-Confidential Rx

4-PW Polling

5-Memory Rx Mode Start time-End time

Password

 Security Function setting

 1  On the LCD home screen, select [Setting]→ [Fax setting] → [Security].

▼

▼
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Menu Item Description Value

Password Set password to use for security. 4-digit number

Confidential Tx Use this function to send document confidentially to your destination. On
*Off

Confidential Rx This security option can be used to receive encrypted documents 
only from the Tx device set with the same password.

On
*Off

PW Polling When Tx/Rx polling use this function to allow the fax communication
only in the devices set with same password.

On
*Off

Confidential polling For printing security of received files, use this function not
to allow to be printed when it is recevied between the set time.
Received documents in other time can be printed with no restriction.
When changed from On to Off, all pending documents are printed.
This function is temporary. After the set time is finished, the
function becomes disabled to Off.

On
*Off
Enter time (HHMM 
~ HHMM)
Enter password

 * is the factory default setting.

 2  After finishing security function setting, select the [Save] button. 
   To cancel selections, press [Cancel].
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4.5 Report & List   

  Report setting table

Report 1-TCR print

2-Print Report Always on

On error

Tx err only

Rx err only

Off

3-BCTx result set

4-Tx Image Insert

 Report print and setting

 1  On the LCD home screen, select [Setting]→ [Fax setting] → [Report].

▼

▼
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Menu Item Description Value

TCR print Select to print history and choose result display format.
*Descending order: Most recent events come first.
Ascending order: In the order of event time

*On
Off
*Descending order
Ascending order

Print Report Set the condition to print Tx/Rx result report. Always on
*On error  
Tx err only
Rx err only 
OFF

BCTx result set Set to print the result report when all Tx are completed. *On
Off

Tx Image Insert Set to insert image in the first page of the Tx result report. On
*Off

 * is the factory default setting.

 2  After finishing report setting, select the [Save] button. 
   To cancel selections, press [Cancel].
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5. Print setting
5.1 Print setting table

Print setting 1-Print density

2-Setting priority Printer 

Driver

3- Ratio of PDF storage printing Original size

Auto

5.2 Print setting

 1  On the LCD home screen, select [Setting]→ [Print setting].

▼

▼
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Menu Item Description Value

Print density Set a density for printing 1~9
*5

Setting priority Set the priority between printer settings and driver setting. Printer
*Driver

Ratio of PDF storage 
printing

When printing PDF file by a storage device,Setting for the size 
of the print

Original size
*Auto

 * is the factory default setting.
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6. Total counter table
6.1 Total counter table

Total counter 1-Total Print

Duplex

Copy

2-Scan Scan

Exposure glass scan

ARDF scan

ARDF duplex scan

3-Fax Print

Send

4-Print Host

5-Print Report

6-Print USB driver

7-Serial Number

6.2 View total counter

 User can view a total counts of the jobs performed in the device.

 1  On the LCD home screen, select [Setting]→ [Total counter].

▼
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▼

   

 2  As the figure above, user can view the total counts of the device using.
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7. Administrator
 This menu can be accessed only with the administrator password and it allows administrator to change password and  
 back up/restore address book.

7.1 Administrator menu table

Admin Change PW Password

Auth

User manual auth. auth.

auth password

Address book Back up/Restore

Port enable RAW Print

IPP Print

LPD/LPR Print

RAW Scan

Httpd

Menu Item Description Value

Password 
Change

Password Change a password. OK

User manual 
auth.

auth. Set a password when waking up from sleep mode and 
Turn on the power

On, *Off

Address book Back up/restore Back up address book, or restore address book from USB. Backup/restore

Port enable RAW Print Using the Raw port (port 9100) in the printer driver *On, Off

IPP Print Using the IPP protocol (port 631) *On, Off

LPD/LPR Print Using the LPD / LPR protocol (port 515) *On, Off

RAW Scan Using the Raw port (port 9101) of the scan driver *On, Off

Httpd Using device embedded Web server functions (port 80) *On, Off

 
  - For address book back up/restore, USB memory must be inserted to the device.

  - The default admin password is “admin”.

7.2 Enter Administrator mode
 When the password for the administrator permission is entered, user can enter the administrator mode.
 1  On the LCD home screen, select [Setting]→ [Admin].
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▼

 2  Enter a password on the LCD keyboard and select [Auth.].
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 3  Access to the administrator menu

7.3 Change password

 1  On the LCD home screen, select [Setting]→ [Admin] to enter the admin menu.

 2  Select [Change PW] to change the password to access the administrator mode.

7.4  User manual auth.

Set a password when waking up from sleep mode and turning on the power.

 * The initial password : 0000
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1  After entering Administrator menu, please select the [User manual auth]

2  You can change the password.

7.5 Address book

 Address book can be backed up in USB or restored from USB.

 1  In the LCD home screen, select [Setting]→ [Admin] and select [Address book].

▼
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 2  After connecting the USB memory to the device, a USB backup message appears.

 3  When [Backup] is selected, the address book will be backed up in the USB memory. 
   The file name saved is address.bak.

 4  To restore the address book, insert the USB memory with address.bak to the device and select [Restore].

7.6  Port enable.

The menu for network port on / off.
Once these settings are changed, the system will automatically restart.

1  After entering Administrator menu, please select the [Port enable].
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2  Save the changes and the system will automatically restart.
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1. Job manager
 Job Manager shows all the jobs in the device.

 1  Select [Job manager] on the LCD home screen to enter the job manager mode.

 2  The following screen is displayed when you enter the job manager.

1.1 All 
  The job manager shows a list which includes all current and stand-by jobs.
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1.2 Fax
  The job manager shows a list which includes all current and stand-by fax jobs.

1.3 Copy/Scan/Print
  The job manager shows a list which includes all copy/scan/print jobs in progress.

1.4 Fax log
  The job manager shows a list of all fax jobs completed.
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2. ID copy
 1  Select [ID copy] on the LCD home screen to use the option.

 2  Select [Setting] to choose options and press 【 】 button.

 

 
  - The result of output can be varied depending on the place of ID and the setting of the copy. 
 

  3  When the front side is scanned, the following pop-up window appears.

 4  As instructed on the screen, face down the back side of ID and select 【 】 button to scan again to print.
   When you select [Stop], only the front side is printed.
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3. Address book
 In the address book, user can save information of frequent contact numbers, and access the information conveniently     
 for scan or fax job.

3.1 How to add new user
 1  Select [Address book] on the LCD home screen.

 2  Select the [+] button.

 3  Enter each field and select [Save].
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 4  Check the added user on the list.

 5  To edit information, select a user on the list to view a pop-up window and select [Edit] on left top 
   of the pop-up window (same procedure from hereafter as new add).

3.2 How to add group
 1  Select [Group] from [Address book].
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 2  Select [+] in the [Address book].

 3  The procedure from hereafter is as same as adding a new user.

3.3 Delete from address book
 1  Select a user or group and enter the detailed information pop-up or edit screen.
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 2  Select [Delete] on left bottom.

 3  Check if the entry is deleted from the list.

3.4 Search address book
 1  Select the magnifying glass icon [  ] on the upper right of the address book.
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 2  When you select the search window of address book, the LCD keyboard appears. 
   Enter a search word and select [Search].

 3  Check the searched list.
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3.5 Address book table

Address book User Registration number

Name

Group

Fax

Speed dial

E-mail

Net folder server, path, ID, password, port

FTP server, path, ID, password, port

WebDAV server, path, ID, password, port

Group Registration number

Name

Users
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4. Program function
 The program function allows user to save changed settings in GUI and use it again when using main 
 functions (copy/scan/fax) later.

4.1 How to add program
 1  Select [Program] on the main function screen (copy/scan/fax) to save specified settings 
   and use it again.

 2  Select [Copy program], [Scan program], or [Fax program]
   and select [New].

 3  Enter a program name and creator on the screen. Then select an identity color and press [Save].

 4  The saved program is added on the list.
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4.2 How to use saved program
 1  Select [Program] on the main function screen (copy/scan/fax) to save specified settings 
   and use it again.

 2  Save program list is separated by each function tab. Select a program tab from [Copy program], 
   [Scan program], or [Fax program] and select a program to load from the list.

 3  According to the specified settings for the program, a changed function screen appears on the screen.

4.3 Edit or delete registered program
 1  Select [Program] on the main function screen (copy/scan/fax) to save specified settings  and use it again.

 2  On the program list, select [  ] for the entry to edit or delete. Then you can select  [Edit] or [Delete].
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 3  Select [Edit] to change name, creator, or identity color of the program.

 4  Select [Save] to apply the changes.

 5  To delete a program, select [Delete] on the selection screen of [Edit] and [Delete].
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5. Web browser
 User can use web browser installed in the device. User can use the web browser to surf or search internet
 sites or use bookmark, and web page print function.  

 
  - “On” must be selected for [Setting] → [General] → [Basic] → [16-Web] for device to use Web.

5.1 Run web browser
 1  Touch button of [web browser] on the home screen  which web browser has been activated

 2  The web browser opens and shows the home page.

 3  User can use the tool bar on the top of the screen to go back / forward, enter URL, refresh, go homepage, set 
   bookmark, print webpage, or configure settings.
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5.2 Go to homepage
 Use the menu on the top tool bar to go to the home page selected.

 1  Go to a web page to save and select [  ] on the top tool bar.

 2  You can use ◀, and ▶ icons in the tool bar to go to web pages you previously visited.
   Also you can enter URL, or refresh page. Click URL input window and use keyboard to enter 
   address.

5.3 Use bookmark
 You can save a frequently used web page and go to the web page without entering URL.
 You can save/edit/delete a bookmark

 1  Go to a web page to save and select [  ] on the top tool bar.
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 2  You can view list of bookmarks previously saved. 
   Select a bookmark from the list to go to the bookmark.

 3  To save, select [ ] on the upper right of the screen.

 4  The first field shows the name of bookmark and the second field shows URL. Select the first field and  
   use keyboard to enter a bookmark name. Select [Save] to save, or select [Close] to cancel.
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 5  After you save, you can view a newly added entry.

 6  To delete an entry, select [Edit] on the upper right 
   of the screen. Select [  ] on each entry to delete it.

 7  To change an entry, select [Edit] on the upper right of the screen. 
   When you select an entry, the name and URL of the entry are displayed.
   Select the first field and use keyboard to change name.
   It is as same as saving a bookmark.

 8  To exit bookmark, select [Close] on the upper right of the screen.
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5.4 Print web page
 You can print the web page currently being displayed.

 1  Go to a web page to save and select  [  ] on the top tool bar.

 2  Select Setting and [Print Page] to start printing. To cancel printing, press [Cancel].

 3  If you are using a map service website such as Google, you can print the map using the same printing popup  
   window.
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5.5 Web browser setting
 You can configure settings for web browser.
 There are five options available: Homepage Setting, Delete History, Delete Cache, Text Encoding, and Default  
 Settings.

 1  Go to a web page to save and select  [  ] on the top tool bar.

 2  Use the home page setting menu to set up a home page
   This web page appears when you open a web browser after booting device or when you select [  ] on the
   top tool bar. Use the delete history menu to delete web pages accessed after booting device.
   After this function is used, Back / Forward buttons cannot be used until new pages are accessed.
   Select the delete cache menu to delete images of the accessed page saved in the device.

   Use the text encoding menu to change the encoding method.
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 3  Use the Default Settings menu to reset all settings.

5.6 Close web browser
 1  To exit the web browser, select the 【Home】 button.



8-21

Additional Functions 8

6. Internet fax
6.1 Internet fax
 Internet fax is used to send or receive faxes via internet.
 Internet fax uses email functions of internet to send or receive fax documents. Therefore, you can send or receive 
 faxes without worrying about communication fee when you send a fax to a long distance destination or send faxes in  
 a batch.

3

6

54

2

1

   1. Originals
   2. Email + attachment(in TIFF format)
   3. Internet
   4. SMTP server
   5. POP3 or IMAP server
   6. Internet fax Rx

  Before using the internet fax, check the followings:

    Internet fax uses emails to send or receive documents.

   Internet fax sends a fax document in a format of attachment (TIFF file) to an email via internet. 
    The receiving device which supports internet fax receives an email and prints the attachment.

   You need an exclusive email address for internet fax.

   Connect a device to TCP/IP network available for internet fax communication.

   Depending on the network status, attachment may not be properly sent or received when you send 
    an internet fax as email message.

   This device supports internet fax communication of documents in black/white.
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6.2 Internet fax setting

 
  - “On” must be selected for [Setting] → [General] → [Basic] → [15-Internet fax] for device to use Web.

 Internet fax setting
 1  Internet fax must be properly set before you use the internet fax function.
   Select [Setting] → [Fax setting] → [Internet fax] to configure internet fax settings.

 2  When you select [Internet fax], the below screen appears.

The following table shows the overall structure of internet fax settings.

Internet fax user setting Use Tx func.

Use Rx func.

User name

E-mail address
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Internet Fax Tx Setting SMTP Server

Use Rx server login Info.

SMTP ID

SMTP password

SMTP security

SMTP port

Retry Tx

Internet Fax Rx Setting Server type

Server Address

ID

Password

Security

Server port

Interval for checking Rx

Print mail contents

Internet fax detail setting MDN request

MDN response

DSN request

Checking time for MDN/DSN 
response

Print MDN response

Print DSN response

Print Tx report

Print Rx report

Internet fax general setting

Item Description

Use Tx func. Select [On] or [Off] to use internet fax Tx function.
* Default: On

Use Rx func. Select [On] or [Off] to use internet fax Rx function.
* Default: On

User name Enter a user name to use for internet fax.
Example> User Name

E-mail address Enter an email address to use for internet fax.
Example> email@domain.com
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Internet-Fax Tx Setting

Item Description

SMTP Server Enter a SMTP server address to use for internet fax mail transmission.
example> smtp.domain.com

Use Rx server login
Info.

Select [On] or [Off] for using server login information to log in to the SMTP server.
If [On] is selected, the ID and password configured for basic settings
are used to log in the SMTP server.
* Default: Off

SMTP ID Enter the log in ID to the SMTP server for internet fax email Tx.
Depending on the SMTP server settings, it may request ID only or email address.
For details, contact your email server admin.

SMTP password Enter the log in password to the SMTP server for internet fax email Tx.

SMTP security Select [Off], [SSL], [TLS], or [STARTTLS] depending on the security setting of the 
SMTP server to use.
For details on security options, contact your email server admin.
* Default: Off 

SMTP port Enter a port for the SMTP server to use.
Port #25 is usually used for the SMTP server without security option. Contact your 
email server admin for port number of SMTP server with secruity option.
* Default: 25

Retry Tx In case transmission of internet fax email is unsuccessful due to network failure,
enter a number of transmission re-trials between 0 and 10. Set a higher number
if the network environment experience frequent failure.
* Default: 3 times

Internet-Fax Rx Setting

Item Description

Server type Select [POP3] or [IMAP] for your server type to use in internet fax email Rx.
For details on server type, contact your email server admin.
* Default: POP3

Server address Enter a server address to use in internet fax email Rx. 
example> pop3.domain.com

ID Enter a log in ID to the server to use in internet fax email Rx.
Depending on the server setting, only ID is required or email address is required. 
For details, contact your email server admin.

Password Enter a log in password to the server for your internet fax email.

Security Select [Off], [SSL], [TLS], or [STARTTLS] depending on the security setting of the 
server to use. For details on security options, contact your email server admin.
* Default: Off
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Item Description

Server port Enter a port of the server to use.
Port #110 is usually used for the POP3 server without security option.
Port #143 is usually used for the IMAP server without security option.
Contact your email server admin for port number of POP3 or IMAP server 
with security options.

Interval for checking Rx Select an interval to check if there is a new internet fax email automatically.
Between 1 and 120 minutes.
* Default: 10 minute 

Print mail contents Select [On] or [Off] to print the email body when you receive an internet fax 
* Default: On

Internet fax detail setting

Item Description

MDN request When transmitting internet fax email, select whether to send MDN request.
Select [On] or [Off]. MDN can be requested only when there is one fax receiver.
* Default: off

MDN response When transmitting internet fax email, select whether to send a response to MDN
request. Select [On] or [Off].
* Default: off

DSN request When transmitting internet fax email, select whether to send DNS request.
Select [On] or [Off]. DSN can be requested only when there is one fax receiver.
* Default: off 

Checking time for MDN/DSN 
response

When transmitting internet fax email, select whether to send DNS request.
Select [On] or [Off]. DSN can be requested only when there is one fax receiver.
* Default: off
If the MDN/DSN response check is [On], select a time to wait for the message.
Select a time between 1 hour and 99 hours. After the set time is finished, 
MDN/DSN response is no longer checked for the message.
* Default: 24 hour

Print MDN response Select [On] or [Off] to print a MDN response message or not when it is received.
This option works only when MDN request is set to [On].
* Default: Off

Print DSN response Select [On] or [Off] to print a DSN response message or not when it is received.
This option works only when DSN request is set to [On].
* Default: Off

Print Tx report Select [Off], [Success], or [Fail] to print a result report when internet fax email
Tx is unsuccessful. [Success] and [Fail] can be selected together.
* Default: Fail

Print Rx report Select [Off], [Success], or [Fail] to print a result report when internet fax email
Rx is unsuccessful. [Success] and [Fail] can be selected together.
* Default: Fail  
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  - SMTP: stands for Simple Mail Transfer Protocol. This is a standard protocol for email Tx/Rx.

  - POP3: stands for Post Office Protocol Version3. This is a standard protocol used when the mail client
   receives an email from the mail server.

  - IMAP: stands for Internet Message Access Protocol. This is a standard protocol used when the mail client
   receives an email from the mail server.

  - MDN: stands for Message Disposition Notifications. This is a message used to send confirmation
   response from Rx device to Tx device for internet fax email.

  - DSN: stands for Delivery Status Notifications. This is a message used by the mail server for Tx/Rx
   to show the mail transfer status.

  - The MDN message and options for DSN message work only when there is one fax receiver.
   Also, depending on the device settings on Rx side and mail server, the MDN or DSN message may not 
   be sent and it may be ignored or deleted.

6.3 Internet-Fax send Setting

 Send internet-fax

 
  - To use the Internet-Fax send function, [Use Tx func.] in the internet fax setting menu must be set to [On].

 1  Touch button of [Internet fax] on the home screen  which Interner fax has been activated

 2  Enter a recipient to receive the internet fax. You can manually enter the recipient or use address book to   
   select one. Select [Add receiver] to manually enter a recipient.
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 3  Enter an email address of the receiver and enter the title and body of the email.

 4  Select [Address book] to add a receiver in the address book. For details on 
   address book, see P. 7-5 「3. Address book」.

 5  Select original size, resolution, original type, density and duplex settings as needed.
   For details on settings such as original size, see P. 5-5 「2. Fax setting」

 6  Select [Receive-side mode] on the internet fax screen to select options for attached file suitable for the Rx  
    device. You can select MH, MR, or MMR as compression method for attachment file and choose a 
   paper size such as A4, B4, or A3.

 7  Check the settings for original and receiver. Then load original paper and select 【 】 button.
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6.4 Internet-Fax receive Setting

 Receive internet-fax

 
  - To use the Internet-Fax receive function, [Use Rx func.] in the internet fax setting menu must be set to [On].

 This device can receive an internet fax email message automatically or manually.
 When an internet fax is received, the attachment is automatically printed. The body of email message is printed when 
 the option is on.

 

  - This device can print TIFF Profile-S and TIFF Profile-F format document only.

  - This device can print a body of email message written in ASCII characters only.

  Receive email automatically

   On the time interval set for Internet-Fax receive Setting, the device checks and prints a new internet fax message  
   from POP3 server or IMAP server

 

  - A value between 1 and 120 minute can be set as interval to check the email.

  - The default value is 10 minutes.

  Receive email manually

   Away from the auto Rx checking, user can check internet fax email message from the POP3 server or IMAP
   server right away when needed. Select [Extended] on the internet fax screen and choose
   [Manual Rx].
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6.5 Additional functions

 Check job history
 1  User can check Tx and Rx job history of the internet fax. To check the job history, on the internet fax screen,
   select [Extended] and [Job history].

 2  On the job history list, select a job to view details.
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7.  Sindoh sPrint App
The Sindoh sPrint app is a freeware which makes user print or scan documents, available on smart devices such as 
Android smartphone and tablet. From smart device connected to the network where the MFP is connected to, user 
can print documents or images.

 
 - MS Office (Word, Excel, Powerpoint) files are converted into PDF files through the Google Drive PDF  
  conversion service. Google account is required in this case.

 
  - User can search “Sindoh” or “Sindoh sprint” in Google Play Store to find the application and install it. 

 

 - The sPrint page may change without notice.
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7.1  Print with sPrint App

1  Touch the document icon to print a document.

2  Select a document to print from the list in smart device.
  If the document is a PDF or Text file, preview screen for the document is available. If the document is a MS Office  
  file, it is converted with Google Drive to display the preview screen. Select an image from the Home screen to  
  print the image.
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3  Check the preview screen. When needed, select the setting icon to change options such as a number of print  
  copies or paper size. Then select the print icon to print.

7.2  Scan with sPrint App

User can receive scan data with user’s smart device by using the sPrint App. 

1  User can receive scan data with user’s smart device by using the sPrint App. 

2  If there is a document on ARDF, this document will get scanned. If there is no document on ARDF, a document  
  on flatbet glass will get scanned.

3  Select desired options in the Scan Home screen of the sPrint app. (resolution, file type, and more)

4  When user selects the Scan button of the sPrint app, the device scans document and creates a file in the format 
  set by user. Then the file is sent to smart device.

5  When smart device receives the file, the status bar on top displays an icon and the app shows the list of   
  received files.
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7.3  Use NFC Tag to Print/Scan from Smart Device

User can touch the NFC antenna of smart device, where sPrint app is installed, on NFC tag of MFP to pair them 
together. The smart device must support Near Field Communication (NFC). See the user manual for smart device to 
find the location of NFC antenna. Check if Sindoh sPrint app is installed in the smart device. 

 
 - If there is no communication between MFP and smart device after touching the smart device on tag, 
  adjust the position of smart device and touch it on the tag again.
 - When an obstacle such as metal blocks the NFC tag of MFP and NFC antenna of smart deivce, 
  communication between MFP and smart device may not be established. 

How to Pair MFP and Smart Device

1  Touch the smart device with sPrint app on the NFC tag of MFP.

2  sPrint app will run in a while and pairing between MFP and the smart device will be complete.
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1. Use Web Monitor
 This section explains how to run the web monitor and how to understand each section in the web browser.

1.1	 Device	configuration
  TCP/IP is required to run functions on the web monitor.
  Options can be used in the web monitor after the device is configured to use TCP/IP.

1.2 Available options
  The following options can be used remotely on the user computer via Web Monitor.

 - Show device status and settings

 - Manage address book

 - Configure device

  1  Open your web browser.

  2  In the address window of web browser, enter “http: //(device IP address or host name)/”.
     The start page for the web monitor opens.

1. Menu section

3. Display section

2. Left menu bar

 1.  Menu section
  When you select a menu, this option is shown in the display section or in the left bar section.

 2. Left menu bar section
  Details on each tab are displayed.
 
 3. Display section
  Details on the selected option in the menu are displayed on the screen.
  Device information in the display section is updated automatically every 10 seconds.

 
  - This web page is optimized for Internet Explorer 9.0 or higher.
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2. About menu
2.1 Menu
  You can view or change settings on the device status, document manager, job history,
  or user environment. However, the settings cannot be changed for some devices.

1. Home 2. Address book  3. System Setting  4. Web Print

 1. Home
  On the left menu bar, [Status], [Counter] and [Inquiry information] tabs are displayed.
  In the job section, the details on the tab menus are displayed.

 2. Address book
  Users without certification information can be added, changed, or deleted. User can only view information on users  
  with certification information.

	 3.	System	Setting
  User can change settings for the device. In the Admin contact setting, the phone number of service center,
  URL of web page, and sales branch/phone number can be entered.

 4. Web Print
  A document uploaded in the web site can be printed. Also, copy quantity, tray setting, print density, duplex setting,
  and collate copy can be configured.
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3. Settings list
 The below table shows options in the web monitor which can be found in the web browser.

3.1 Home

Menu (phase 1) Menu (phase 2) Menu (phase 3)

Home Status Status

Toner

Drum

Device information

Tray

Counter Total page counter and page count for each option

Inquiry Service center

Sales branch

3.2 Address book

Menu (phase 1) Menu (phase 2) Menu (phase 3) Menu (phase 4)

Address book Address book Add user Basic information

Group

Email

Net folder

FTP

WebDAV

Fax

Detailed User Info Same as (add user)

Edit user Same as (add user)

Delete user

Group Group Group information

Page

Total number of groups

Display number

Sort

Search group list

Create group Group name

User group list (same as group)

Edit group Group name

Delete group
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3.3 Setting

Menu (phase 1) Menu (phase 2) Menu (phase 3) Menu (phase 4)

Settings General Basic setting Panel Key Sound

Power Save

Auto power off

Auto initialize time

Time zone

Wait[Busy]

Wait[Idle]

Slide effect

Dust Remove

Unit

Language

3.4	 Copy	setting

Menu (phase 1) Menu (phase 2) Menu (phase 3)

Settings Copy Copy Quantity

Original size

Tray

Type

Print density

Copy density

Auto density

Intensity

Copy scale

Duplex

Collate

Copy quality

General Scan Wait Time
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3.5	 Scan	setting

Menu (phase 1) Menu (phase 1) Menu (phase 3)

Settings Scan Save in

Original size

Color/B&W

Resolution

File type

JPEG quality

Scan density

Duplex

General scan Wait time

3.6	 Fax	setting

Menu (phase 1) Menu (phase 2) Menu (phase 3)

Settings Fax Genearal Setting

Send Setting

Receive Setting

Report print Set

Fax security

Internet fax

3.7	 Print	setting

Menu (phase 1) Menu (phase 2) Menu (phase 3)

Settings Print Print density

Setting priority

3.8	 Network	setting

Menu (phase 1) Menu (phase 2) Menu (phase 3) Menu (phase 4)

Settings Network setting Wired network Auto setting

Manual setting

Mac Address

E-mail transfer setting SMTP (e-mail transfer setting)

Status e-mail alert Email alert availability, Admin e-mail setting
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3.9	 Paper	setting

Menu (phase 1) Menu (phase 2) Menu (phase 3)

Settings Paper setting Tray Priority

Substitute A4/Letter

Limitris MPT 

Use

Tray 1

Tray 2

Tray 3

Tray 4

MPT

 
  - Depending on the security setting, some options may not be displayed.
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1. Replace consumables
 The LCD shows a message when consumables need to be replaced. 
 When you see the message asking for replacement, please identify the
 consumables in the message and replace it.

1.1 Toner bottle

 

 When a message, “No toner”, appears on the LCD screen, replace the toner. For details on
 how to replace a toner bottle, see P. 10-2 「1.2 Change toner bottle」.

1.2 Change toner bottle
 When a toner is almost used up, a message, “Toner near end”, appears on the LCD screen.
 You may continue to use the device, but please replace the low toner bottle with a new toner bottle.
 When a message, “No toner”, appears on the LCD screen, all toners have been used up
 and the device cannot print any more. Replace the older toner bottle with a new one.

 How to replace

 
  - Shake a new toner bottle between 5 and 10 times before installing it.

  - The toner bottle used up will be collected at a service center do not throw away and keep it in a box.

 
  - Do not burn a toner bottle or throw it into the fire. You may get burned due to scattered toners.

  - Make sure your hands, clothes or internal device is not stained with toner.
   Wash them away with clean water or mild washing liquid if your hands are stained with toner.

  - If toner gets in your eyes, wash them away with clean water and consult your doctor.
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  1  Open the front cover.

  2  Turn the knob to loosen it (①) and pull out the used toner unit (②).

      

  3  Take out a new toner bottle out of the box and shake it 5 to 10 times.

 
  - If the toner is installed without shaking, it may cause unsteady supply of toner.
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  4  Push a new toner bottle with locking knob open (①) and turn the knob to fasten (②) and secure it.

      

 
  - If you force the toner unit downward to install it, the toner may get scattered. Make sure that you  
   maintain horizontal balance to push the toner in.

  5  Close the front cover.
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2. Clean device
 This section describes how to clean the device. Only professional technicians are allowed to perform any cleaning, 
 maintenance, and recycling not described in this section.

 
  - Do not use benzene, thinner or other cleaning chemicals as they may damage plastic parts and paint.

  - Do not use toilet papers or paper towers to clean the device. They may stick to the inside of the device to 
   cause static electricity. Use soft clothes not to damage the outer surface of device.

2.1 Clean outer surface
 Dip the soft cloth into water or soft cleaner, wring it out completely, and then clean the outer surface of device.

2.2 Clean scanner area
 If the scanner area is dirty, copied documents may have unwanted spots, or scanned or faxed documents may
 have a black line. Clean the scanner area on a regular basis.

 Clean ARDF, flatbed, flatbed cover, and pad
 Dip the soft cloth into water or soft cleaner, wring it out completely, and then clean the surface. And wipe the surface 
 with the clean dry cloth. If the surface is covered with dust, dip the soft cloth into a little amount of soft cleaner, clean 
 the device, and then clean the device with another clean and dry cloth.

Automatic Reverse
Document Feeder (ARDF)

Automatic Reverse 
Document Feeder 
(ARDF) glass

Flatbed cover

Flatbed pad

Flatbed glass
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2.3 Clean printer area
 For the following cases, clean the roller in the printer area.

 Frequent paper jams

 Low print quality

  - Dip the soft cloth into water, wring it out completely, and then clean the 
   surface. And wipe the surface with the clean and dry cloth.

  - Rotate the roller with your hand and wipe down the whole roller downwards.

 
  - The fuser unit and its surrounding areas are very hot while the device is operating.

  - Do not touch the fuser unit and its surrounding areas. It may cause burns.

 
  - Do not touch the OPC drum with your hands. It may cause print errors.

OPC Drum

Roller

Roller



10-7

Maintenance and Troubleshooting 10

3. Fix document or paper jam
 When document or paper jam occurs, its location is displayed on the LCD panel.
 Follow the below instructions to remove the jammed document or paper carefully.
 If the jammed paper cannot be removed, contact Sindoh customer support center or service center.

3.1 Document jam
 When a document is jammed in ARDF, a message “ARDF jam occurs, Remove the paper.” appears.
 Remove the jammed document carefully.

 
  - Do not force to pull out the jammed document even though it is not released easily.
   If you force to release or pull it too hard, you may tear off the paper.
   Remove the jammed document carefully.

  1  Pull up and open the ARDF cover (①).

  2  Remove the jammed paper (②) carefully. If you cannot remove the jammed paper, 3  go to step.
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  3  Pull up and open the ARDF cover (①) and remove the document (②) carefully.

  4  Lift up the document feeder (①) and remove the jammed document (②) carefully.

  5  Lift down the document feeder. Close down the ARDF cover.

3.2 Paper jam
 If paper jam occurs while printing, a message appears on the screen depending on the type of jam.



10-9

Maintenance and Troubleshooting 10

 
  - The fuser unit and its surrounding areas are very hot while the device is operating.
   Do not touch the fusing unit and its surrounding areas when you remove jammed paper or check
   the inside of device. It may cause burns.

  - When you remove jammed paper, prevent your eyes or mouth from toner powder. 
   If toner gets in your eyes or mouth, wash them away with clean water and consult your doctor.

 
  - When paper jam occurs while printing, some toner powder may not be settled on the paper
   Make sure your hands or clothes are not stained with toner.
   Wash them away with cold water if your hands or clothes are stained with toner.
   If you wash it with warm water, the stains may remain permanently.

  - Carefully remove the jammed paper so that no trace of paper is left inside the device.

  - Do not touch the internal parts and terminals of the document transfer roller.
   It may lower the print quality.

  - Do not touch the surface of the OPC drum. It may cause print errors.

 
  - Open the cover displayed on the LCD panel and close it. This may make an error message disappear.

 Follow the below steps to remove the jammed paper carefully

  1  Pull the side cover lever to open the side cover.
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  2  Hold the jammed paper with both hands and carefully pull out the paper to remove.

            

  3  If paper is jammed inside the fusing unit, remove the paper carefully.

            

 
  - The fuser unit and its surrounding areas are very hot while the device is operating.
   Do not touch the fusing unit and its surrounding areas when you remove jammed paper or check
   the inside of device. It may cause burns.

  4  If paper is jammed in the duplex unit, open the unit (①) and remove the jammed paper (②) carefully.

            

  5  Close the side cover.
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3.3 Remove paper jam in optional feeder (Tray 3)
  1  Open the cover (①) on the right bottom of the optional feeder (Tray 3). Open the right cover (②). 
   Pull out the jammed paper (③) with both hands to remove it carefully.

  2  Make sure there is no paper jam and close the covers in the reverse orders of removing paper jam.

            

 When you close the right cover (②), make sure that you firmly push in the area of the hand image, as in figure, to 
 close the cover.
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3.4 Remove paper jam in optional feeder (Tray 4)
  1  Open the cover (①) on the right bottom of the optional feeder (Tray 4). Open the right cover (②). 
   Pull out the jammed paper (③) with both hands to remove it carefully.    

            

  2  Use the same steps for the optional feeder (Tray 3) to close the cover of the optional feeder (Tray 4).                          
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4. Error messages
 When communication or device error occurs, a warning signal in red light will appear on the LED status display.
 Then an error message appears on the control panel or the message gets printed to alert users.

4.1 Warning messages in LED status display
 When communication or device error occurs, a warning message appears on the LED status display.
 If the warning signal remains, take a necessary action to fix the problem.
 When the cause of error is fixed, the device becomes stand-by.

  Red light is on the LED display when

    - paper jam occurs

    - cover or cartridge is open

    - a serious device error occurs

    - there is no paper

    - there is no toner

    - memory is insufficient while receiving fax

    - memory is insufficient while saving document

  Error messages printed

    When communication or device error occurs, description of the error is displayed on the LCD panel. Check the 
    message and take a necessary action. 

   - Example of printed message
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4.2 Typical error messages and troubleshooting

  Operation problems and device errors are displayed on the panel. For the messages not listed below,
  take necessary actions according to the message.

Message Cause Troubleshoot

Cancel (copy, scan, fax,
Print) job?

While working on copy, scan, fax, 
print job, 【 】 button is pressed, or 
cancel in the admin screen is
selected.

-

Paper jammed in the
Scanner. Remove the paper.

Paper is jammed in scanner.
“ARDF internal original jam”
appears depending on jam.

Open the scanner cover and remove the
jammed paper.

Paper jam: XX
Remove the paper.

Paper is jammed inside the device. Remove the jammed paper.

No toner: No remaining
toner. Replace toner.

Toner has reached its life span. Toner has reached its life span.

Ready to replace drum The remaining life of the drum is 
10% or less

Prepare to replace the drum.

Drum replace required The drum unit is exhausted. Contact service staff to replace the drum unit.
(Remaining capacity is approximately 1000 
pages.)

Replace drum unit :
Drum exceeded its usage
limit.

Drum unit cannot be used
any more. Replacement is
required.

The device will not be working any more.
Contact service staff to replace the drum unit.

Re-install the toner bottle
again.

Toner bottle is not installed
properly.

Re-install the toner bottle again.

Paper mismatch:
Tray and the paper size
do not match. Reload
papers.

The tray to use contains incorrect
size of papers.

Check the paper size and load again.

Device cover is open. Device cover is open. Close the device cover.

Tray cover is open. Tray cover is open. Close the tray cover.

ARDF cover open:
ARDF cover is open. Close 
it.

ARDF cover is open. Close the ARDF cover.

Fax memory lack There is insufficient fax memory
for fax Tx/Rx.

Delete Fax Pending job saved
in the memory.

No phone line Phone line is not connected
to MFP.

Connect a phone line to MFP and try fax
Tx/Rx again.

Searching Wifi Searching for accessible Wifi
signals.

Wait until any accessible wireless AP
is available.
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Message Cause Troubleshoot

Wifi search failed There is no wireless AP available 
for connection.

Check your wireless AP.

Connect USB memory USB drive is not accessible
when using USB scan / print.

Make sure that USB drive is connected
properly.
To recognize USB drive, it may take
about 5 seconds after you insert it.
Wait 5 seconds or longer before you access 
it. Some USB driver may not be recognized. 
Use a different USB driver and try again.

Dust over the limit
has been detected
on ARDF glass.
Continue?

While you scan/copy on ARDF,
a warning message appears 
when dust continues to present 
over the limit.

Remove dust or dirt before resume the job.
If you disregard and continue to scan or copy 
documents,
the copied or scanned document may have 
black vertical lines.

Set the time. Time setting is required. Select [Setting]-[General] to set the time.

(Model name)
Firmware update

Update the firmware with new
system code (model name in ( ))    -   While programming system code, do 

       not turn the power off.

EC : (error code)
Turn power off and power
on again.

An error occurred in the device.
Make sure MFP and optional
accessories work properly.
If you are not a professional staff,
call customer center
or sales dealer.

   -   Error code appears if system
       check-up is required.
       Call customer support center
       or contact MFP admin.
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5. Troubleshooting
 When a problem occurs in the device, refer to the table below.
 If your problem cannot be fixed after you follow the suggestions or instructions below, please contact Sindoh
 customer support center.

 
  - If you sense unusual sound, smell or smoke from the device or overheating from the scanner, unplug 
   the power cord immediately and contact one of Sindoh customer support center.

  - Problems caused by unauthorized repair, remodel or consumables may not be covered by warranty.

5.1 Device is not working

Status Check Troubleshoot Reference page

Device is not working. Device is not working. Turn the power switch and
power cord on.

P. 6
「3.4  Power switch」

Power switch is not “ON”. Turn the power switch “ON”. P. 6
「3.4 Power switch」

Nothing appears
on the screen.

[Power save] lamp is turned
on.

Device is in power save mode.
Exit the power save mode.

P. 6
「3.4 Power switch」

No paper out Paper is jammed or other
object is jammed.

Check the error message and
remove jammed paper or
object.

P. 10-8
「3.2 Paper jam」

Frequent paper jam
or wrinkled paper.

Paper is not properly loaded. Load papers properly. P. 1-27
「9. Load papers」

Paper size is not properly 
set.

Select a proper paper size
for the paper tray.

P. 1-27
「9. Load papers」

Inappropriate papers are 
used.

Use proper papers specified
in the user manual.

P. 1-24
「8.1 Available papers」

Paper is wet or humid. Replace with new dry papers. -

Paper is folded or wrinkled. Remove inappropriate paper
and replace with new papers.

-

Paper is jammed or other
object is jammed.

Remove paper or object jam. -

Cartridge is not properly
installed.

Make sure that cartridge is
pushed in fully and installed 
properly.

-

No document out Paper is jammed or any 
object is jammed in ARDF.

Remove the jammed paper
or object and place an original
again.

P. 10-7
「3.1 Paper jam」
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Status Check Troubleshoot Reference page

Frequent paper jam Inappropriate papers are 
used.

Use appropriate papers. P. 1-24
「6.3 Available original」

Original guide is not adjusted
properly.

Adjust the document guide
to the original accordingly.

P. 1-27
「7. Place original」

Trace of document remains
in the ARDF.

Open the cover of ARDF
and original tray to remove
any paper trace.

P. 10-7
「3.1 Paper jam」

Roller in the original tray is
dirty.

Clean the roller in the original
tray.

P. 10-5
「Clean ARDF」

Time settings or
speed dial settings
disappear.

Device is turned off for a 
long time or the power gets 
turned off every day.

Batteries which save settings
may have gone dead.
Contact Sindoh’s customer
support center for help.

-

Cannot close the cover. Cover is not closed properly. Push both sides of the cover
to close it.

-

Rolled documents are 
out and other paper 
rollings are observed.

- Reverse the side of paper in 
the tray (back to front).

-

Cannot send. Incorrect phone number. When using speed dial,
make sure that the phone
number in the address book
is correct.

P. 5-2
「1. Basic fax
functions」

External connection number
is not included.

When dialing from internal
line to external line, make
sure to include an external
connection number.

-

Document cannot be
sent continuously.

Documents to send are not
not aligned or sorted togeth-
er
properly.

Place the documents again. P. 1-19
「7. Place original」

A page smaller than the size
limit is included in the
document to send.

Separate a smaller page and
send it by using flatbed glass.

P. 1-19
「7. Place original」

After numbers are
diailed, document 
cannot be sent.

Wrong phone number Make a call to a correct
number.

-

Line is busy. Wait until the call is finished. -

When using memory Tx,
document cannot be 
scanned.

Document is placed properly. Place the document properly. P. 1-19
「7. Place original」

Memory is insufficient. Check if memory is sufficient. -
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5.2 Cannot receive a call

Status Check Troubleshoot Reference page

No Rx Phone line is not connected 
to phone line outlet properly.

Connect the phone line
properly.

-

Memory is insufficient. Check if memory is sufficient. -

5.3 Problems regarding image quality

 If your problem cannot be fixed after you follow the suggestions or instructions below, please contact Sindoh
 customer support center.

Problem Cause Troubleshoot Reference page

Printed document is too
light (blurred or unclear).

Paper is wet. Replace with new papers. P. 1-27
「9. Load papers」 

Text in the document is
 in light color.

Ask sender to send a
document in black text.

-

Inappropriate papers are
used.

Use papers specified in the
user manual.

P. 1-24 「8.1 Available
papers」 

Density is not proper
for copying.

Use a proper density. P. 2-13 「7) Density」 

Toner is very low. Replace it with a new
toner unit.

P. 10-2 「1.2 Replace 
toner bottle」

White or black dot is
printed.

Inappropriate papers are
used.

Use proper papers. P. 1-24 「8.1  Available
papers」

Flatbed glass or pad is
dirty.

Clean the flatbed glass or
flatbed press pad.

P. 10-5 「2. Clean 
device」

Vertical black line or 
smudges are printed.

Flatebed glass or
feeder roller is dirty.

Clean the flatbed glass or
feeder roller.

P. 10-5 「2. Clean 
device」
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Problem Cause Troubleshoot Reference page

Aligned smudges or
lines are printed.

Dirt or dust is stuck in the
paper feeder path.

Perform a test copy
a few times.

-

Black line or smudge
is printed.

Paper is wet. Replace with new papers. P. 1-27 
「9. Load papers」 

Inappropriate type of papers
are used.

Use appropriate type of 
papers.

P. 1-24 「8.1 Available
papers」  

Flatbed glass or pad is
dirty.

Clean the flatbed glass or
original press pad.

P. 10-5 
「2. Clean device」

Device malfunction. Contact Sindoh’s customer 
support center.

-

Whole paper is printed
in black.

Device malfunction. Contact Sindoh’s customer
support center.

-

Nothing gets printed. Back side of a document
is placed instead of front side.

Place a document properly. P. 1-19
「7. Place document」

Multipe papers are loaded. Sort and brush the papers
before loading.

-

No toner. Replace with new toner unit. P. 10-2 「1.2  Replace 
toner bottle」

Device malfunction. Contact Sindoh’s customer 
support center.

-

Paper is wrinkled or
printed fonts are too
light.

Inappropriate type of papers
are used.

Use appropriate type of
papers.

P. 1-25
「8.1  Available
papers」   

Paper is wet. Use new papers. P. 1-27
「9. Load papers」 
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Problem Cause Troubleshoot Reference page

Overall printing quality 
is poor and dirty.

Original with dark background
such as newspaper.

Check if the copy density
is dark.

Select “Auto” for density
when making copy for
original with dark backgroud.
If the copies are still dark
when “Auto” is set, adjust the 
density lighter.

P. 2-13
「7) Density」

Paper edge is dark 
and dirty.

Original press pad is dirty. Clean the original press pad. P. 10-5
「2. Clean device」

Check if the paper is larger
than the original.
(When zoom is 100%)

Select the same size of paper
as original.

-

Scale is not reduced to fit. Reduce the scale to fit
the paper.

P. 2-13
「8) Scale」

Make sure that the orientation
of document and that of
original match.

Select the same orientations.

Or adjust the document
orientation to match the paper 
orientation.

-

Image is tilted. Original is not placed
properly.

Place the document properly. P. 1-27
「7. Place original」

Inappropriate document for
ARDF.

Use a document
appropriate for ARDF.

P. 1-24
「6.3 Available
original」 

Dirt or dust on flatbed glass. Clean the flatbed glass. P. 10-5
「2. Clean device」

Paper is not loaded properly. Load papers properly. P. 1-27
「7. Place original」
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6. Power Shutdown
6.1 Power shutdown

During a call May continue to keep calling.

During Tx Transmission will be interrupted.
If memory Tx is interrupted due to power shutdown, it is transmitted again.
automatically when power is supplied again.
If it is Onhook transmission, Tx will not resume automatically. Send the document again.

During Rx Rx will be interrupted.
If power supply resumes, received print jobs prior to power shutdown resume and
pages will be printed.

During copying
During printing
received fax
During printing list

Printing will be interrupted.
For faxes, if power supply resumes, received print jobs prior to power shutdown
resume and pages will be printed.

During scanning Scanning will be interrupted.

6.2 Device operation while power shutdown

Copy Not available.

Fax Tx Not available.

Fax Rx Not available.
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7. When problems cannot be fixed
 If your problem cannot be fixed after you follow the suggestions or instructions in this user manual, please contact   
 Sindoh customer support center or service center.

 
  - If you sense unusual sound, smell or smoke from the device or overheating from the scanner, unplug  
   the power cord immediately and contact one of Sindoh customer support center. Do not disassemble
   or repair the device on your own.

  - Problems caused by unauthorized repair, remodel or consumables may not be covered by warranty.
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1. Product information
1.1 Product information

Model N610, N611, N612, N613, MF2083, MF3033, MF4041, MF4091.

Type Desktop

Photoreceptor type OPC

Copy type Laser Dry-Static Shooting

Development type Dry 2 Element Magnetic Brush

Fuser type Heat Pressure Roller

Flatbed type Fixed

Original read type One-dimension shooting by CCD, CCDM movement for sub-shooting

Ready time Time to be ready for printing after power switch is ON : Less than 56 seconds

Print speed (first page) Less than 6.5 seconds (N612/N613/MF4041/MF4091)
Less than 8 seconds (N610/N611/MF2083/MF3033)

Continuous copy speed 
(A4 LEF paper, full scale)

26 sheets/minute: N610, MF2083
30 sheets/minute: N611, MF3033
40 sheets/minute: N612, MF4041
45 sheets/minute: N613, MF4049

Original for copy Paper, book, 3-dimensional object

Load Quantity Standard Output Tray : 250 sheets (plain paper)
Upper Output Tray : 100 sheets (plain paper)

Max paper size FB: Up to A3 or Ledger (11” x 17”)
ARDF: Max width 297 (min. 139.7) x length 1,000mm (less than 300dpi) 
           (Fax only if length exceeds  431.8mm)

Copy size Tray 1
Width: 139.7 (5.5”) – 297 (A4    ) mm 
Length: 182 (B5) – 364 (B4) mm 
Tray 2
Width: 139.7 (5.5”) – 297 (A3) mm 
Length: 182 (B5) – 431.8 (17”) mm 
Manual paper try (MPT) 
Width: 90 – 297 mm 
Length: 139.7 (5.5”) – 431.8(17”) mm 

Margin deletion Top        3(+2/-2.5)mm
Bottom  3(+2/-2.5)mm
Left        3(+2/-2.5)mm
Right      3(+2/-2.5)mm

Paper thickness 1) Device paper tray, Tray (for single size papers) paper thickness: 60~220g/㎡
     Paper type: regular, recycled, thick
2) Manual paper tray
     Paper thickness: 60~220g/㎡
     Paper type: regular, recycled, thick, OHP, envelope
3) Paper available for duplex
     Thickness: 60~209g/㎡
     Type: regular, recycled, thick
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Copy Scale 1. Metric & Asia Pacific 
50%,71%(A3→A4, B4→B5), 82%(B4→A4, B5→A5), 
87%(A3→B4, A4→B5), 115%(B4→A3, B5→A4), 
122%(A4→B4, A5→B5), 141%(A4→A3, B5→B4), 200% 
2. Inch:
50,65%(11×17 →8.5×11), 78%(11×17 →8.5×14), 
79% (8.5×14 →8.5×11), 122%(8.5×14 →11×17), 
130% (8.5×11 →11×17), 155% (5.5×8.5 →8.5×14), 200% 
Zoom range: 25~400% (zoom can be manually adjusted by 1% unit)

Resolution 600 dpi (dot per inch)

Feed type Tray: Retard Roller
Manual tray: Roller with torque limiter

Continuous copy 1~999 sheets

Power AC 220~240V, 50/60Hz, 4.5A (N613/N612/MF4041/MF4019)

AC 220~240V, 50/60Hz, 3.8A ( N611/N610/MF2083/MF3033)

Max power consumption N613,N612,MF4091,MF4041: 1100W

N611,N610,MF2083,MF3033: 900W

Size 
(Width×length×height)mm

559×599×802.9mm (width×length×height) - Including ADF but not control panel

Weight About 55Kg (with ADF)

1.2 About electromagnetic interference
If the device is in the vicinity of another electric device, they may be affected by each other. If TV or radio is close to 
the device, a noise may be created. If so, take the following actions.

- Place the device away from TV or radio as much as possible.
- Adjust the direction of antenna of TV or radio.
- Use a different power outlet source.

1.3 Copy Specifications

Item Specification

Scan Resolution Scan: 600dpi×600dpi

Warm-up Time Less than 56 seconds (Time to be ready for printing after power switch is ON)

First page out Less than 6.5 seconds (N612/N613/MF4041/MF4091)
Less than 8 seconds (N610/N611/MF2083/MF3033)

Continuous Copy Speed (FB, A4  , Tray 1)
Regular papaer: 45 PPM (N613/MF4049), 
                           40 PPM (N612/MF4041) 
                           30 PPM (N611/MF3033), 
                           26 PPM (N610/MF2083)
                           Thick paper(1,1+,2,3): 18 sheets/min

Multiple copies 1~999
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1.4 Scanner Specifications

Item Specification

Driver TWAIN Driver
WIA Driver

Color Grayscale 600 dpi, Color 600 dpi,

Half Tone 256 level

Resolution 150 dpi, 200 dpi, 300 dpi, 600 dpi

Size A3, A4(    ,    ), A5(    ,    ), B4, B5(    ,    ), B6, Letter, Legal, etc

Type USB Scan, Network Scan

Interface - USB 2.0 port
- Ethernet 10Base-T/100Base-TX /1000Base-T

OS TWAIN – Vista/7/8/8.1/10
WIA – Vista/7/8/8.1/10 

Speed Black & White : 55 ipm, Color : 45 ipm (When ADF 300dpi A4 LEF)

Supported File Format JPEG, TIFF, PDF

1.5 Fax Specifications

Item Specification

Scan Line Density G3（8dot/mm ｘ 3.85line/mm ~ 600 x 600 dpi）

Transmission speed 2.4kbps-33.6kbps

Line type Public Switch Telephone Network, Private Branch Exchange,
G3 (Fax communication web)

Transmission time In 2 seconds (A4, V.34, 33.6kbps, JBIG)

Encoding Method MH/MR/MMR/JBIG

ECM Supported

Memory Rx 4000 pages

1.6 Printer Specification

Item Specification

Speed 26 / 30 / 40 / 45 ppm

Resolution Black & White: 1200dpi X 1200dpi (real)

Color Black & White

Interface USB1.1, USB 2.0, USB_Host 2.0
Ethernet 10Base-TX/100Base-TX /1000Base-TX ,Wifi IEEE802.11 b/g/n

Language PCL5e, PCL 6(XL), Postscript Level 3, PDF v1.7(Direct Print)

Embedded Fonts PCL 5e/6(XL) : 45, PS : 136

Compatible OS Windows 7/8/8.1/10 (32/64 Bit)
Windows XP SP3 (32/64Bit,)/Vista (SP2 32/64Bit)
Windows Server 2008 R2 SP1 / Server 2012
Macintosh OSX 10.5, 10.6, 10.7, 10.8, 10.9, 10.10
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Item Specification

Supported Protocols IPv4/V6
DHCP, DNS, RAW, FTP, SMTP, WebDav, IPP, lpr/lpd, POP3, HTTP (TCP),
SNMP(UDP)

Paper size Tray 1
Width: 139.7 (5.5”) – 297 (A4    ) mm 
Length: 182 (B5) – 364 (B4) mm 
Tray 2
Width: 139.7 (5.5”) – 297 (A3) mm 
Length: 182 (B5) – 431.8 (17”) mm 
MPT (Manual paper tray)
Width: 90 – 297 mm 
Length: 139.7 (5.5”) – 431.8(17”) mm

1.7 Automatic Reverse Document Feeder (ARDF)
It feeds original documents automatically page by page.

Mode
ARDF mode, mass documents,
Mixed size. original orientation set

Original size A3 ~ A5 (INV ~ 11”x17”)
Vertical: 139.7~297mm, Horizontal: 139.7~431.8mm

Original thickness 1-side original
: 35 to 128 g/m2 (9-5/16 to 34-1/16lb)
2-sided original
: 50 to 128 g/m2 (13-5/16 to 34-1/16 lb)

Paper capacity 90 sheets (when using regular paper 75g/㎡)

Copy speed At 1:1 ratio, 55 PPM (A4 LEF, 1:1 ratio)
Varies depending on settings and images.

Size 
(width×length×height)mm

559×474×96mm

Weight Approximately 6 kg or less

1.8 Accessories

Device
Name

N610 Series

Quick Guide (with warranty certificate) ○

User manual (full) CD ○ 

Install Guide ○
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1.9 Consumables table
 Consumables for this device are as follows.
 To order consumable parts, contact Sindoh’s customer support center or service center.

Consumables

Toner unit

Drum Unit (DR)

                                     

Developing Unit (DV)

                                     

Fuser Unit

                                     

 
   - Do not store consumables in the following place.

    Place with high temperature or humidity
    Place exposed to flames
    Place exposed to direct sunlight 
    Place with a lot of dust

   - Do not unpack consumables before it is used.

   - Problems caused by using unauthorized consumables may not be covered by warranty.





- The warranty period for device is one (1) year and warranty copy limit is 60,000 sheets. When the number of copies made 
 exceeds the number of warranty copy limit, the device is no longer covered by warranty even within the warranty periods.
 ※Average usage : N613, MF4091 :10,000 sheets / month, N612, MF4041 : 9,000 sheets / month  
                                    N611, MF3033 : 5,800 sheets / month , N610, MF2083 : 4,300 sheets / month
                                    (Based on A4 size, 5% chart)

-  Estimated Usage of Supplies

Category First installation Sales Remark

Toner unit 20,000 sheets 20,000 / 30,000 sheets

＊ A4, 5% chart based
＊ Testing temperature : 23±2℃

＊ Humidity: 50±10%RH (ISO/IEC 19752)

Drum unit

100,000 sheets (N610,N611,MF2083,MF3033)
＊base on 3 page / job

110,000 sheets (N612,N613,MF4041,MF4091)
＊base on 4 page / job

Developer 250,000 sheets

Fuser unit
300,000 sheets(N610,MF2083), 320,000 sheets(N611,MF3033)
400,000 sheets(N612,MF4041), 440,000 sheets(N613,MF4091)

※ When images take 5% or more area of A4 size paper, the life of toner, drum, and developer may be shortened faster.
※ Errors may occur depending on the user environment (temperature, humidity, image density and paper type).
※ Sindoh uses its own claim process standard for device and consumables.
※ 3 pages/job: 3 pages are printed for one job (consumable usage may vary depending on the pages printed).

-  Replace/manage consumable parts  
      (CS : service staff    ▲ : must clean or inspect    ◎ : replacement based on the number of printed pages)

Category Item By

Period of service (# of prints)
Remark50,

000
60,
000

100,
000

150,
000

200,
000

300,
000

600,
000

Drum and its 
surrounding

Fusing Roller CS ◎

P Sensor CS ▲ Wipe with cloth

Feeder re-
turning parts

Regist roller CS ▲

Clean with alcohol or water

Rear return roller CS ▲

Feed roller unit CS ▲ ◎

Separation roller unit CS ▲ ◎

Manual feeder 
separation roller unit

CS ▲ ◎

Manual feed roller CS ▲ ◎

Dust collect box (driven) CS ▲ ◎ Replace driven part
(replace with drum unit)Dust collect box (motor) CS ▲ ◎

Fusing parts

Fusing separation part CS ▲

Use anhydrous ethanol to wipe 
with cloth

Fusing guide plate CS ▲

Fusing roller CS ▲

Pressure roller CS ▲

ARDF

Pickup roller CS ▲ ◎ Use alcohol and cloth to clean 
(replace 3 parts together)

Feed roller unit CS ▲ ◎

Separation roller unit CS ▲ ◎

Each idle roller CS ▲

Use alcohol and cloth to cleanScan Guide CS ▲

Sensors CS ▲

Filter Odor removing filter CS ◎ ※Only for devices in China
Developer Developer unit CS ◎

※  The replacement table above is based on using A4, 5% chart in normal environment and the replacement chart   
      may apply differently for using other papers. 
※  The above replacement schedule must be followed as the replacement parts specified above directly affects the   
      image quality and device operation.
※  Other parts not specified above can be replaced when it is broken or necessary and those parts need to be re        
      placed or repaired by a professional technician.
※  When an error occurs before the replacement schedule is passed, it will be handled in accordance with the claim  
      process standard by Sindoh.

Product warranty conditions (for N610/MF Series)



※ This device is in the Class A items.

Notice to users

 Class A items 
 (Broadcast communications  
 unit for business use)

 Class B items  
 (Broadcast communications  
   unit for household use)

This class A product is registered in Electromagnetic 
Compatibility, and User may be required to take ad-
equate measures for other purposes than household 
use.

This class B product is registered in Electromagnetic 
compatibility and is for domestic environment and also 
for general use

Type Notice

Delivery procedure

 As TOE is delivered by delivery driver and installation engineer assigned   
  from the seller. Users will be received the multifunction copier from 
  employee sent from seller.

 Users are asked to check whether below listed materials are included in    
  multifunction copier package when delivered.

  * Multifunction copier, User manual (including CD), Quick user manual 
     book, Quick installation guide, Accessory (Toner bottle, developer pouch, 
     power cord)

 Users can check if correct item is delivered as installation engineer support  
  to install the copier and print the system information report that verifies 
  the product is what user requested.

 Both user and seller keep one copy of receipt and transaction receipt after  
  user check the item is identical with item description, and is being operated 
  normally.    
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